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ABSTRACT 

 

Vitamins are the organic compounds essential for normal growth and metabolic processes in all 

living organisms. B vitamins, such as vitamin B9 and B12, act as cofactors in various metabolic 

reactions, including one-carbon (1C) metabolism, and typically are required in trace amounts. The 

gut harbors a diverse population of bacteria, some of which are capable of producing certain 

vitamins. These bacteria also require vitamins for their growth and proliferation, with requirements 

varying between vitamin-producing and non-producing strains. However, bacterially synthesized 

vitamins are limited, and dietary intake is vital for meeting the host’s daily requirements. Despite 

the well-understood functional role of B vitamins, their precise impacts on gut ecology remains 

poorly understood. The current study aimed to investigate the impacts of vitamin B9 and B12 

deficiencies on gut morphology, microbial composition, and their metabolites using a rodent model 

of vitamin deficiency. Our findings revealed that a deficiency in vitamin B9 or B12 altered mucosal 

height and decreased acidic mucin production in the colon. Of particular interest, we observed sex-

dependent differences in the effects of vitamin deficiency on the gut microbial profile. The analysis 

of fecal metabolites showed notable alterations in metabolites associated with gut health in the 

vitamin-deficient groups compared to the control. This study provides evidence that deficiencies 

in B vitamins, particularly those involved in 1C metabolism, can disturb gut homeostasis in a sex-

dependent manner. 
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1.0 Introduction 

 

Micronutrients, such as vitamins, play important roles in different metabolic processes [1]. 

Deficiency of these micronutrients is a major health concern and is mostly prevalent in  developing 

countries [2]. While the roles of diet and dietary factors in regulating gut microbial composition is 

well-known, the impact of micronutrient deficiencies on gut homeostasis is less studied [3]. 

Among micronutrients, the water-soluble vitamins, B family is of particular significance as it is 

not synthesized by the host and thus, must be obtained  from either the dietary intake or supplied 

by gut microbiota[4]. In the gut, almost 100 known bacterial species can produce B vitamins and 

symbiotically exchange them to survive [5]. Biosynthetic pathways for vitamins can differ among 

species, which highlights the existence of genetic variations [6].  Various taxa have evolved to 

fulfill specific roles in the synthesis and utilization of vitamins [7]. For instance, Bacteroidetes 

utilize a well-recognized thiamin biosynthesis pathway, whereas organisms like Salmonella 

enterica, which lack this pathway, depend on transporters to acquire thiamin [8]. Among all the 

vitamins synthesized in the gut, riboflavin and niacin are the most commonly produced vitamins 

[5]. However, despite the production of  these vitamins by the gut microbiota,  several factors  such 

as site of production and competition between host and non-producing bacteria, result in an 

insufficient supply  to meet the daily requirements of the host [5]. Consequently, individuals rely 

on dietary intake to meet their requirements of these micronutrients.  

B vitamins, specifically vitamin B9 and B12, play vital roles in one-carbon (1C) metabolism, a 

shared biological pathway involved in various physiological activities. For example, it plays a 

critical role in DNA synthesis, production of methyl donors, amino acid homeostasis, and redox 

defense [9, 10]. Water-soluble vitamins i.e., B vitamins serves as co-enzymes as well as methyl 
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donors in 1C metabolism [11]. A slight alteration in this cycle may have association with several 

diseases including cardiovascular disease, Alzheimer’s, cancer, and others [12].  

Mutual symbiosis between the gut microbiota and the mammalian gut has shaped their 

interdependence, and the microbiota’s ability to produce essential substances is heavily influenced 

by the host environment. The synthesis of these vitamins in the gut requires specific molecules and 

substrates, such as para-aminobenzoic acid (pABA) for folate synthesis and precorrin-2 for B12 

production [5]. The synthesis of these precursors is also dependent on the availability of substrates 

in the gut. Thus, it is reasonable to assume that micronutrients, such as vitamin B9 and B12, could 

play a crucial role in the gut homeostasis. In the current study, we investigated the influence of 

dietary vitamin B9 and B12 on gut morphology, gut microbiota composition, and microbial 

metabolites using a B9 and B12 - deficient rat model. 

1.1 Background 

 

Vitamins are a group of organic compounds required for normal physiological function [13]. They 

are mainly divided into two groups: water-soluble and fat-soluble. Water-soluble vitamins such as 

B vitamins, (specifically vitamin B6, B9 and B12) play vital roles in several enzymatic reactions, 

including 1C metabolism. For example, folate and B12 play a critical role in the biosynthesis of 

DNA, lipids, proteins, methyl donors, and redox molecules [14]. Maternal 1C is also essential in 

controlling the methyl group for epigenetic functions and influencing gametogenesis and 

zygogenesis [15]. Perturbations of these metabolic pathways are associated with several diseases 

such as cardiovascular disease, Alzheimer’s, neural tube defects, renal impairment, megaloblastic 

anaemia, congenital cardiac condition, non-alcoholic fatty liver disease, and cancer [12]. Our gut 

microbiota can produce a small amount of these vitamins, which is insufficient for the host’s daily 
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requirements and therefore, requires dietary supplementation [16, 17]. As such adequate dietary 

intake of these vitamins is not only crucial for humans, but they are also essential for maintaining 

normal gut bacterial functions. Here, we discuss the details of vitamin B9 and B12 and their impact 

on gut microbiota. 

1.1.1 Vitamin B9 or folate 

1.1.1.1 Discovery of folate 

 

The search for a cure for megaloblastic anaemia in the late 1870s and early 1880s resulted in the 

discovery of folate. Scientists found that incorporating animal liver in meals along with other 

vitamins improved the anaemic condition [18]. In 1941, Mitchell and his colleagues gave the term 

“Folic acid” to this vitamin. They isolated it from spinach and named it after the Latin word folium, 

which means leaf. Later, they discovered it’s potential to promote the growth of bacteria such as 

Streptococcus lactis [19]. 

1.1.1.2 Structure of folate 

 

Folate or pteroylglutamate is a generic term which refers to a larger family of compounds which 

contains a 2-amino-4-hydroxy-pteridine ring, a p-aminobenzoyl moiety, and either monoglutamate 

or poly-γ-glutamate moieties [14] The folate family can comprise as many as 150 compounds 

because of varying combinations of 1C unit, pteridine oxidation moiety, and different 

polyglutamate chain lengths [20]. This 1C unit can attach either at N5 or N10 position (marked 

red) or both (Figure 1.1). The 2-amino-4-hydroxy-pteridine ring is linked with p-aminobenzoyl 

moiety with a methylene (CH2) group, and the p-aminobenzoyl moiety is further linked with an 

amide bond to the α-amino group of either monoglutamate or poly-γ-glutamate moiety. Though 
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this is a large family of compounds, however only one-third of them (<50) is found in plants and 

animals [21].  

 

Figure 1.1. Chemical structure of folate. Three distinct chemical moieties are linked together to 

form the chemical structure of folate. The structure is divided into three parts, 2-amino-4-hydroxy-

pteridine ring link with a methylene bridge to a p-aminobenzoyl linked via amide bond to poly-γ-

glutamate. Figure is generated with ChemDraw. 

 

1.1.1.3 Digestion, absorption, and metabolism of folate 

Folate is highly bioavailable when consumed in its pure form on an empty stomach. For instance, 

folic acid, the supplemental form of folate, has an 85% bioavailability, whereas its bioavailability 

decreases when consumed as a part of food [62]. Dietary folate exists in both free and conjugated 

forms [22]. Free folic acid mostly exists as a ployglutamate form in foods and must be transformed 

to monoglutamate before absorption. This conversion reaction is mediated by folate conjugase in 

the brush border of the proximal small intestine by glutamate carboxypeptidase II (GCPII, E.C. 

3.4. 17.21) [23, 24]. Folate is primarily absorbed in the jejunum section of the small intestine and 
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poorly absorbed in the alkaline distal part of the intestine or colon [23, 25]. The absorption of 

folate is mediated by the pH-dependent carrier, proton-coupled folate transporter (PCFT, 

SLC46A1), Reduced Folate Carrier (RFC, SLC19A1), and three glycosylphosphatidylinositol-

anchored receptors (FOLR1–3) [10, 26, 27]. Once absorbed, monoglutamate folate is converted 

into first 5-methyl tetrahydrofolate (THF), which occurs in the enterocyte of the jejunum brush 

border, and then it is transported into the portal vein by multidrug resistance-associated protein 

(MRP) [28, 29] (Figure 1.2). Folate circulates to the portal system and reaches targeted tissues by 

using either RFC or receptor-mediated endocytosis of the folate receptors (FRs), primarily the 

liver. In the liver, folate is stored temporarily as monoglutamate form before being released into 

the plasma when needed by converting monoglutamate into polyglutamate form [28]. The amount 

of folate excreted from the body ranges from 0.3 to 0.8% of daily folate intake [30, 31], primarily 

in the urine as p-aminobenzoylglutamate and its derivates [32]. Interestingly, as much as 90% of 

total body folate remains in circulation in the body fluid, while only 10% is stored in the tissues 

[33]. 
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Figure 1.2: Absorption, transport, and cellular uptake of folate.  GCPII; glutamate 

carboxypeptidase II, PCFT; proton-coupled folate transporter, MRP; multidrug resistance-

associated protein, RFC; reduced folate carrier. 

 

1.1.1.4 Assessment of folate status 

 

Folate status can be assessed using dietary intake, blood biomarker concentration, or a combined 

method of these two [34]. According to Biomarkers on Nutrition and Development (BOND), 

serum and total red blood cell (RBC) folate levels are two of the main biomarkers for assessing 

folate status [35]. Assessment of folate status can be done through direct or indirect methods. 

(i) Direct method for folate quantification 

 

Folate concentrations can be directly measured using body fluids such as serum, RBC and urine. 

Serum folate concentration only reflects current dietary intake, but repeated measurement of serum 

folate periodically in one person can be used to identify folate deficiency [35]. On the other hand, 

RBC folate is used as a long-term indicator of folate status and represents approximately 40-50% 
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of total body folate [35]. It reflects the folate status in RBC during erythropoiesis, thus indicating 

the folate status over the last three months [14]. RBC folate status also indicates tissue folate status, 

such as liver folate content [36]. Urinary folate is also combined with serum and RBC folate to 

determine the daily average folate status [37].   

(ii) Indirect method for folate quantification 

 

Microbiological assay methods 

 

Microbiological assays can be used to quantify the concentrations of B vitamins, as these vitamins 

are required for the growth of specific groups of bacteria. Several lactic acid bacteria, specifically 

Lactobacillus casei, are used for such assays. This assay can quantify the total folate present in a 

sample. However, the limitation of this assay is it can not distinguish between different forms of 

folate that co-exist in the sample [38]. Having said that, L. casei contains a vitamin B12-dependent 

methionine synthase (MS, also known as MTR, EC 2.1.1.13) which converts 5-methylene-THF to 

5,10-methylene-THF [39]. This capability can be used to differentiate between polyglutamate and 

monoglutamate forms of folate based on the growth [40]. 

Deoxyuridine Suppression Test 

 

Through 1C metabolism, folate plays a vital role in DNA synthesis by providing S-adenosyl 

methionine (SAM) [41]. SAM is essential for maintaining the integrity of specific parts of 

chromosomes via cytosine methylation [42, 43]. SAM deficiency results in cytosine 

hypomethylation and, consequently alterations in DNA [44]. Folate is required for deoxythymidine 

triphosphate (dTTP) synthesis via donating 1C to deoxyuridine monophosphate [35]. Uracil is 

removed from the DNA by two enzymes: uracil-DNA glycosylase and apyrimidinic endonuclease, 
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creating an unrepairable nick in the DNA strand [45]. This conversion of deoxyuridine 

monophosphate (dUMP) to dTTP and these resulting nicks are fully dependent on the availability 

of folate [41, 46]. Therefore, the amount of uracil content in DNA can be used as a genomic 

biomarker for folate status. Excessive uracil accumulation can lead to micronuclei formation and 

presence of micronuclei can also be an indicator of folate status [47]. However, micronuclei 

formation is not exclusively associated with folate deficiency but can also be triggered by 

deficiencies of other vitamins and minerals [14]. 

1.1.1.5 Folate Deficiency 

 

Folate is primarily absorbed in the jejunum via several active and passive transporters. Therefore, 

patients with intestinal disorders of the small intestine, such as coeliac disease and amyloidosis, 

suffer from folate deficiency [48]. The clinical progression of folate deficiency involves changes 

in serum folate levels followed by a reduction in RBC folate and an elevated homocysteine (Hcy) 

level [49]. Folate deficiency can cause neural tube defects (NTD), megaloblastic anaemia, 

pancytopenia, glossitis, male infertility, angular stomatitis, and oral ulcers. Megaloblastic changes 

in bone and tissues are also observed in the second stage of folate deficiency [50]. These 

morphological changes are accompanied by cellular changes in neutrophils (hyper segmentation 

of nuclei) and lymphocytes (formation of micronuclei) [14]. Abnormal erythrocyte production and 

decreased oxygen-carrying capacity of the blood result in weakness and tiredness [51, 52]. 

Additionally, depression, irritability, insomnia, cognitive decline, fatigue, and psychosis can occur 

due to folate deficiency [14]. Several factors increase the risk of developing folate deficiency 

including pregnancy, medication, malabsorption, drinking, or other folate inhibitors [53]. 

Identifying folate deficiency at the earlier stage is crucial to prevent anaemia and other deficiency 

diseases. 
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1.1.1.6 Epidemiology of folate status 

 

Epidemiological studies on folate status have been based on either nutrient intake from the food 

supply or plasma/serum folate concentration and have shown high variation between individuals 

[54]. The Recommended Dietary Allowance (RDA) is different at different stages of life. RDA of 

folate is 200 μg for men and 180 μg for women [38, 39]. However, according to the Center for 

Disease Control and Prevention (CDC), all women of reproductive age should take 400 mg of folic 

acid daily. This requirement increases to 600 mg during pregnancy and 500 mg during lactation 

[36, 37]. Among dietary sources, yeast and liver are the richest dietary sources of folate, containing 

2 mg and 300 µg per 100 gm, respectively [41]. 75-80% of folate exists as polyglutamate; with 

90% of folate in vegetables being either 5- or 10-formyl derivatives, while the remaining 10% or 

less is unreduced polyglutamate [42-44]. Regarding folate storage in the body, the liver contains 

approximately 50% of the total body folate [38]. The average serum/plasma folate concentration 

is 13.6 nmol/L, with levels lower than 6.8 nmol/L indicating folate deficiency, whereas 340 nmol/L 

is considered the optimum level of RBC folate [55].  

The prevalence of folate deficiency is less than 20% in developing countries and is significantly 

lower in developed countries, at less than 5% [56]. Less than 1% of Canadians aged 6-79 years 

suffer from folate deficiency, as indicated by RBC folate concentration. Within this age group, 

approximately 40% of the population showed higher RBC folate, more than 1360 nmol/L, whereas 

the optimum level is 340 nmol/L [55, 57].  However, rates of folate insufficiency differ among 

childbearing-age women [57]. According to Canadian Community Health Survey (2015), 22% of 

childbearing-age women exhibited folate deficiency regardless of their age [57], even though 70% 

of women were knowledgeable about the consequences of folate deficiency [58]. 
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1.1.1.7 Factors influencing folate status 

 

Folate status can be influenced by several factors, ethnicity being one of them. Velez and his 

colleagues found a relationship between ethnicity and folate status. According to this study, non-

Hispanic whites (NHW) are more prone to folate deficiency and its associated anemia compared 

to Asians [59]. Other than ethnicity, genetic factors such as the presence or absence of a specific 

allele can be an influencing factor for folate status. The section below describes how these factors 

influence the folate status. 

Genetic factors 

 

Several studies have identified a link between genetic polymorphism, the presence of two or more 

variants forms of a particular DNA sequence, and folate pathway through common C677T variant 

in the gene. MTHFR C677T encodes the enzyme methyltetrahydrofolate dehydrogenase reductase 

(MTHFR), which is required for converting 5,10-CH2-THF into 5-CH3-THF in the folate cycle of 

1C metabolic pathway. Individuals who carry T allele tend to have lower MTHFR activity, leading 

to higher levels of Hcy in their blood [60-62]. Known polymorphisms that affect folate include 

MTHFR C677T and cystathionine β‐synthase (CBS) [63]. 

Drugs 

 

Compounds structurally similar to folic acid can affect the absorption of folate. Several drugs, such 

as methotrexate and aminopterin, can reduce the absorption of folate in the body by inhibiting the 

enzyme dihydrofolate reductase (Table 1.1) [64]. A known diamidine used for the treatment of 

pneumonia has been found to be associated with low serum folate levels [65]. Several antiepileptic 
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drugs (AEDs), such as carbamazepine, gabapentin, oxcarbazepine, phenytoin, primidone, or 

valproate, have been found to be associated with lower serum folate levels [66].  

Table 1.1: Potential inhibitors of folate absorption (adapted from Waxman et al., 1970) [65] 

Folic acid inhibitor Usage 

a. Dihydrofolate reductase inhibitors 

4-amino-4-deoxyfolate Chemotherapy, immunosuppression, proraisis 

2,4-diaminopyrimidine  Malaria 

Triamterene Diuretic 

Pentamidine Pneumosystis carinii 

Trimethiprim Antibacterial 

b. Impaired absorption or utilization of folic acid 

Diphenylhydantoin Prevent and control seizures, antiepileptic  

Primidone Anticonvulsant 

Barbiturates Sedative 

Oral contraceptive pill  Contraception 

 

Physiological factors 

Several physiological factors influence vitamin B9 status, including an individual’s age, smoking, 

obesity, and others. Age contributes to an increase in the frequency of low or insufficient folate, 

ranging from 14% in persons in their 50s and 60s to 23% in those over 80, according to a study 

conducted in Ireland [67]. It is estimated that, among Irish people, one in eight persons over 50 

had low to inadequate folate levels [68]. Apart from age, obese and overweight individuals 
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(BMI > 25 kg/m2) have a 12% lower folate intake and an 8.5% lower serum folate concentration 

compared to healthy individuals (BMI < 25 kg/m2) [69].  Smoking has also been associated with 

lower folate levels compared to healthy, non-smoking individuals [70]. Increased folic acid usage, 

urinary excretion, varying amounts in various tissues, and alteration to folate’s endocrine roles all 

contribute to low folate status [71].  

1.1.2 Vitamin B12 or cobalamin 

1.1.2.1 History and discovery of vitamin B12 

 

Vitamin B12, also known as cobalamin, acts as a co-enzyme for methyl unit transfer reactions. In 

the mid-19th century, pernicious anaemia led Thomas Addison to discover vitamin B12, which was 

later confirmed by Minot and Murphy [72]. Their attempts to treat pernicious anemia with either 

liver or liver extract subsequently prompted other scientists to unravel the chemistry of vitamin 

B12 [73]. 

1.1.2.2 Structure of vitamin B12 

 

Vitamin B12 encompasses a group of compounds that share a complex structure known as 

corrinoid and are interconvertible. This corrinoid family includes all cobalamin compounds, 

characterized by a common feature containing a four-membered pyrrole ring called the corrin ring, 

which houses a central cobalt atom (Figure 1.3). The structure of vitamin B12 consists of two 

parts: the lower part and the upper part. Lower ligands have a base and sugar attached to a 

phosphate group [74]. The upper ligand exists in several forms, including cyano-, methyl-, 

deoxyadenosyl- and hydroxy-cobalamin [75]. Depending on these forms, their bioavailability 

varies. For instance, vitamin supplements are mostly in cyano form, which is more bioavailable, 

while regular foods contain vitamin B12 in five other forms, such as adenosylcobalamin, 
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methylcobalamin, hydroxocobalamin, sulphitocobalamin and cyanocobalamin form [76, 77], 

which are less bioavailable. 

 

Figure 1.3: Chemical structure of vitamin B12 (Image source: Wikipedia) 

1.1.2.3 Digestion, absorption, and metabolism of vitamin B12  

 

The absorption of vitamin B12 takes place in the terminal ileum and varies depending on the type 

of food intake and increases with the intake of food containing a higher amount of B12 [78]. The 

absorption efficiency of the intestine of vitamin B12 ranges from 13 to 66%, depending on the 

type of food and the condition of gut health [79-82]. For example, vitamin B12 found in mutton 

meat is almost 83% bioavailable, whereas it is lower in liver meat, which is 4.5% [81, 83]. Vitamin 

B12, bound to protein in foods, needs to be cleaved from the protein using gastric hydrochloric 

acid to initiate the absorption. This process occurs in the stomach, and free vitamin B12 binds with 

R-protein, facilitating its transport to the duodenum. Upon reaching the duodenum, the R protein-

bound vitamin B12 combines with intrinsic factor (IF). This IF-bound vitamin B12 is absorbed in 
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the ileum in the presence of calcium [84]. It is estimated that only 1.5 to 2 μg of vitamin B12 can 

occupy all the IF in the duodenum [76]. Excess vitamin B12 is excreted through feces, including 

unabsorbed vitamin B12 and bacterially synthesized vitamin B12 in the colon. Daily excretion of 

vitamin B12 is estimated to be around 0.1-0.5% of the body’s stored amount, maintaining a 

consistent ratio between losses and stores [81]. This vitamin is absorbed in distal ileum where IF 

bound B12 is recognized by the receptor and this internalize the B12 into the cell by a receptor 

mediated endocytotic process. At this stage, endosome is generally incorporated with the lysosome 

and the IF are degraded while B12 is released into cytosol [85]. From cytosol, vitamin B12 is 

transported by transcobalamins (TC), such as TC-I, TC-II and TC-III [86, 87]. Transporters, 

specifically TC-II, are clinically significant as TC-II bound vitamin B12 shows the biologically 

active vitamin B12 that is used in DNA synthesis [88]. The excretion of excess vitamin B12 occurs 

through urine or feces, with feces being the primary route for excreting the most substantial amount 

of vitamin B12 [81, 89]. 

1.1.2.4 Vitamin B12 deficiency 

 

Several factors, including certain drugs, gastritis, and ageing, can increase the risk of developing 

B12 deficiency [90]. Vitamin B12 deficiency can cause low haemoglobin, hypersegmented 

neutrophils, neutropenia, macrocytic anaemia, peripheral neuropathy, spinal cord degeneration, 

and cognitive diseases [91, 92]. The most common symptom of vitamin B12 deficiency is signs of 

anaemia, including fatigue and pallor. Another prominent sign of B12 deficiency could be 

jaundice, as a deficiency of vitamin B12 leads towards impaired red blood cell formation [93]. 

Maternal vitamin B12 deficiency is associated with NTD as well as offspring’s brain development, 

possibly through demethylation [94]. One such example is Wnt signalling in the developing 

cerebellum in rats, which has been linked with enduring behavioural and memory impairments 



16 

 

due to a deficiency in methyl donors [194, 195]. Maternal vitamin B12 levels during pregnancy 

can also affect the offspring. In this case, children born to mothers with low levels of B12 during 

pregnancy have been found to have higher adiposity in the torso and increased insulin resistance, 

thereby increasing the risk of type 2 diabetes and cardiovascular diseases [196-198]. 

1.1.2.5 Assessment of vitamin B12 status 

 

Traditionally, the assessment of vitamin B12 status involves measuring its concentration in the 

serum. However, concerns have been raised regarding the reliability of relying solely on serum 

measurements to determine vitamin B12 status [95]. Therefore, additional tests, such as 

transcobalamin-cobalamin complex (Holo) -TC, methylmalonic acid (MMA), and Hcy assays, are 

often employed to further confirm vitamin B12 deficiency. Evaluating Holo-TC levels is 

particularly useful when determining the level of vitamin B12 deficiency as they indicate the 

available B12 for the cells [96]. While MMA only indicates the status of cobalamin metabolism, 

an increase in Hcy indicates potential deficiencies in vitamin B6, B9 and B12, all of which are 

essential for the 1C metabolic reaction.  Having said that these biomarkers can be influenced by 

several factors, such as compromised renal function, specific medication, and genomic changes in 

MTHFR. For instance, polymorphism in MTHFR can elevate Hcy, while impaired renal function 

can cause increased MMA concentrations in the blood [95, 97], which may or may not be 

associated with vitamin B12 deficiency. Therefore, the combined assessment of serum vitamin 

B12 along with subsequent examination of Hcy and MMA values, can provide an accurate 

approach to determine vitamin B12 status [98, 99].  
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1.1.2.6. Epidemiology of vitamin B12 status 

 

The epidemiology of vitamin B12 deficiency varies depending on its etiology. Studies have 

revealed that approximately 1% to 2% of individuals with anaemia suffer from vitamin B12 

deficiency. In contrast, among patients with clinical macrocytosis (MCV) less than 100 femtoliters 

(fL), the percentage of cases associated with vitamin B12 deficiency is higher [14, 100]. It has 

been established that vitamin B12 level below 0.22 nmol/L, an MMA level greater than 260 nmol/L 

and a Hcy concentration higher than 12 μmol/L are indicative of vitamin B12 deficiency [101, 

102].  B12 deficiency resulting in pernicious anaemia is more prevalent among individuals with 

Northern European heritage. Conversely, people of African ancestry or those from other areas of 

Europe have a lower incidence of the disease [103, 104]. The National Health and Nutrition 

Examination Survey (NHANES) conducted in 2015–2016 revealed that individuals belonging to 

low-income status, women, and non-Hispanic blacks have the highest likelihood of having 

inadequate vitamin B12 intake [105]. Approximately 6% of adults under 60 in the United States 

and the United Kingdom have vitamin B12 deficiency, whereas the prevalence rises to around 20% 

in individuals over 60 [106]. According to the Canadian Health Measures Survey (CHMS), from 

2009 to 2011, only 4% of the population did not have sufficient serum levels of vitamin B12 [107].   

1.1.2.7 Factors influencing vitamin B12 status 

 

Several factors including, age, certain drugs, dietary habits, diseases associated with 

gastrointestinal disorders, and a limited number of genetic defects influence one’s vitamin B12 

status. Individuals over 65 are often associated with vitamin B12 deficiency, most likely due to 

reduced gastric acids [108-110]. Certain drugs, including proton pump inhibitors (PPIs), 

metformin, nitrous oxide anaesthesia, specific antiepileptic drugs, and colchicine, are believed to 
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disrupt the absorption or metabolism of vitamin B12. PPIs, which are generally used by older 

people mainly for gastro-oesophageal reflux diseases, reduces gastric acid and ultimately 

decreases the absorption of vitamin B12 [111-114]. Metformin, a well-known drug for diabetes, 

has been found to cause megaloblastic anaemia, a disease related to a deficiency of vitamin B12 

[115, 116].   

Additionally, inadequate dietary intake, alcohol intake, malabsorption of food-bound cobalamin, 

and damaged intestine due to any disease or condition such as celiac disease, Crohn's disease, and 

others can also influence the vitamin B12 status. Individuals who follow a vegan or vegetarian 

diet, frequently suffer from vitamin B12 deficiency if not taking any supplement [107]. As this 

vitamin is primarily absorbed in the terminal ileum, patients with a history of gastric bypass 

surgery, damage in small intestine, pancreatic disease, Diphyllobothrium latum infection, and 

celiac disease have a higher risk of vitamin B12 deficiency [91, 117, 118]. A genetic defect disease 

called Imerslund-Gräsbeck, is known to cause vitamin B12 deficiency due to malabsorption. 

Moreover, mutations in IF, gene-producing TC-transporter and genes involved in vitamin B12 

metabolism C677T gene are also linked to vitamin B12 deficiency  [119-121].  Folate, vitamin 

B12 and 1C metabolic pathway  

1.1.3 Folate, vitamin B12 and 1C metabolic pathway  

 

The 1C metabolism is a pathway nestled with folate and methionine metabolism, where the 1C 

unit is produced. This universal reaction serves to activate and transfer of 1C units for biosynthetic 

processes.  Vitamins such as folate and vitamin B12 play a crucial role in transferring 1C units 

from one intermediate to another, facilitating the synthesis of purines and thymidine, as well as 

other enzymatic reactions such as transmethylation and remethylation [12]. These integrated 
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metabolic reactions can be categorized into three major pathways: the folate cycle, 

transmethylation, and remethylation.  

In the folate cycle, folate facilitates the binding of 1C units to nitrogen atoms at the 5-position of 

the pterdine ring and the 10-position of the para-aminobenzoic acid (PABA) moiety within 

tetrahydrofolate (THF). Since 1C-loaded folates do not move across intracellular membranes, 

producing 5,10-methylene-THF is necessary in the mitochondria and cytosol [122]. This process 

begins with the reduction of folate into dihydrofolate (DHF) and subsequently into THF by DHF 

reductase using NADPH as an electron donor (Figure 1.4). THF is then transformed into 5,10-

CH2-THF by acquiring the 1C unit from the conversion of glycine into serine [123]. The 

conversion occurs based on the demand for these amino acids in cytosol or mitochondria [124], 

facilitated by vitamin B6-dependent enzyme serine hydroxymethyltransferase (SHMT)  [12]. 

Further along the cycle, 5,10-CH2-THF is converted into either 10-CHO-THF by 

methylenetetrahydrofolate dehydrogenase (MTHFD, EC 1.5.1.5) or 5-CH3-THF by enzyme 

methylenetetrahydrofolate reductase (MTHFR, EC 1.5.1.20). This conversion occurs in 

conjunction with the enzyme thymidylate synthase (TYMS, EC 2.1.1.45), which converts dUMP 

into deoxythymidine monophosphate (dTMP) using 5,10-CH2-THF [12]. The conversion of 5,10-

CH2-THF from THF is a reversible process, involving the addition or removal of the methyl group. 

The final step in the folate cycle is the removal of methyl group from 5-CH3-THF [125], which 

requires vitamin B12 as a co-enzyme for MS (Figure 1.4) [126].  

In the transmethylation pathway, S-adenosylhethionine (SAM) is synthesized from methionine 

by methionine adenosyl transferase (MAT, EC 2.5.1.6)  [127]. In the next step, SAM reacts with 

glycine in the presence of the enzyme glycine N-methyltransferase (EC 2.1.1.8) to produce S-

adenosylhomocystein (SAH). This reaction releases one methyl group and sarcosine.  At the same 
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time, S-adenosylhomocysteine hydrolase (EC 3.3.1.1) initiates a reversible reaction resulting in 

the production of Hcy and release of an adenosyl group [128-130]. Sarcosine further converts back 

to glycine catalyzed by mitochondrial sarcosine dehydrogenase (EC 1.5.8.3), releasing one 

partially oxidized methyl group that enters the folate cycle [131]. 

The remethylation pathway occurs by converting Hcy back into methionine [131]. This pathway 

is controlled by two enzymes, MS and betaine–homocysteine S-methyltransferase (BHMT, EC 

2.1.1.5) [132, 133]. These two enzymes utilize methyl groups from folate co-enzyme pool or 

betaine [131]. BHMT uses betaine as a substrate for donating methyl group, converting Hcy into 

methionine, and producing dimethylglycine as a byproduct [134]. Conversely, MS, coupled with 

vitamin B12, produces methionine by utilizing the methyl group from 5-CH3-THF from the folate 

cycle of the 1C metabolic reaction [131] 

As such, the 1C metabolic cycle is also involved in maintaining sulphur-containing amino acids 

such as methionine and Hcy. In the case of inadequate vitamin B12 supply, folate becomes trapped 

in the form of 5-methyltetrahydrofolate, obstructing the restoration of methionine. This 

phenomenon is referred to as a ‘methyl folate trap’ and consequently increases the levels of Hcy 

and its byproducts, which are toxic for the cells [135]. Impairment in the 1C pathway and sulphur 

amino acid metabolism may contribute to the onset of various diseases, including cardiovascular 

disease, cancer, and neurodegenerative diseases such as Alzheimer’s disease [134].  
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Figure 1.4: Role of folate and vitamin B12 in 1C metabolic reaction. Enzymes involved in this 

reaction are as follows: 

1. Serine hydroxymethyl transferase (coenzyme vitamin B6, EC 2.1.2.1): Folate accepts the 

1C unit from serine residue, converts it into glycine, and produces 5,10-CH2-THF. 

2. Methylene-THF reductase: Using FADH2 and NADPH, 5,10-CH2 is converted into 5-CH3-

THF by reducing FAD and NADP. 

3. Methionine adenosyl transferase: Using ATP as an energy source, this enzyme converts 

methionine into SAM with the expense of pPi+Pi. 

4. Glycine N-methyl transferase: This enzyme converts glycine into methylated glycine or 

sarcosine. 

5. S-adenosyl homocysteine hydrolase: Initiates a reversible hydration reaction of SAH, 

converting it into adenosine and Hcy. 
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1.1.4 The 1C metabolism in nucleotide synthesis 

The 1C metabolism is involved in DNA synthesis through three distinct pathways (Figure 1.5). In 

the first pathway, 10-formyl-THF donates two carbons to purine by converting folate into 5,10-

methylene-THF (Figure 1.5 A) [136]. In the second pathway, 5,10-methylene-THF donates a 

methyl group, which is then used in the formation of uracil. Subsequently, uracil is converted into 

thymidine for DNA synthesis (Figure 1.5 B) [137]. In the third pathway, 5-methyl-THF provides 

the methyl group to methionine, which converts methionine into SAM. SAM contributes a methyl 

group to cytosine, thereby regulating gene expression (Figure 1.5 C) [138]. Hcy can be either 

utilized in trans-sulphuration pathway to produce cysteine or be converted back to methionine by 

MS with vitamin B12 as coenzyme [139].  

 

Figure 1.5: Involvement of folate and vitamin B12 in DNA synthesis.  THF, tetrahydrofolate; 

DHF, dihydrofolate; 5,10-CH2-THF, methylenetetrahydrofolate; 10-CHO-THF, 

formyltetrahydrofolate; 5-CH3-THF, 5-methyltetrahydrofolate; DNA-CH3, methylated DNA; 

dUMP, deoxyuridylate; dTMP, thymidylate; Met, Methionine; and Hcy, Homocysteine. 



23 

 

1.1.4 Gut Microbiota 

The human gastrointestinal (GI) tract serves as a significant interface spanning 250 to 400 square 

meters, connecting to its host and various surrounding environments within the body [140]. 

Approximately 100 trillion microbes, encompassing bacteria, fungi, archaea and protozoa, reside 

in the human gastrointestinal tract [141, 142]. These microbes play an integral role in human health 

by bolstering the immune system, maintaining metabolic homeostasis, and modulating 

neurological functions [143-146]. Gut bacteria ferment indigestible substances, such as dietary 

fibers, to produce short-chain fatty acids (SCFA), while also synthesizing B vitamins, 

neurotransmitters, and antimicrobial compounds [147]. Maintaining bacterial homeostasis is 

crucial, as impairment in the composition of these gut bacteria, known as gut dysbiosis, disturbs 

the production of these vital molecules. In fact, gut dysbiosis has been shown to be associated with 

several chronic diseases, including obesity, cardiovascular disease, inflammatory bowel disease 

(IBD), diabetes, coeliac disease (CD), and Alzheimer's disease [148]. 

1.1.4.1 Role of gut microbiota 

 

The gut microbiota maintains a symbiotic relationship with its host. It extracts nutrients from the 

diet and can modulate our metabolism, including nutrient absorption, energy production, as well 

as the synthesis of several vitamins, neurotransmitters, and bioactive compounds. As a result, it 

operates as a distinct organ that possesses a wide range of metabolic capabilities and excellent 

adaptability [149, 150]. The section below provides an overview of functions performed by gut 

microbiota. 

Nutrient metabolism 

The primary source of energy for gut microbiota is dietary carbohydrates. Fermentation of 

indigestible carbohydrates produces SCFA, such as acetate, butyrate, and propionate [151]. Several 
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bacteria, such as Bacteroides, Roseburia, and Bifidobacterium, perform this fermentation process 

[152, 153]. These SCFAs are essential for host metabolism, providing energy to the colon, skeletal 

muscle, heart, and brain [154, 155]. In addition to producing SCFA, gut microbes aid in amino 

acid conversion [156]. Gut bacteria not only help with nutrient metabolism but also synthesized 

micronutrients like vitamins. Approximately 40-60% of the human gut microbiota can produce 

eight B vitamins in the gut [5, 157]. Several genera of bacteria, including Bifidobacterium, 

Bacteroides, and Enterococcus, are commonly known to produce vitamin K and B vitamins in the 

gut [147, 158, 159].  

Antimicrobial protection 

The gut microbiota consists of both beneficial and pathogenic bacteria, and maintaining its 

homeostasis is essential for a healthy gut. The mechanism of antimicrobial action differs between 

the small and large intestines. In the large intestine, two layers of mucus prevent damage of the 

luminal cells from pathogenic bacteria [160]. The inner layer is generally germ-free, whereas the 

outer layer hosts beneficial microbes and provides nutrients to the gut microbiota [161]. On the 

other hand, the small intestine has a much thinner mucus layer, resulting in lesser physical 

protection of the gut from pathogenic bacteria. Instead, antimicrobial proteins produced by the 

beneficial bacteria could play a significant role in protecting against pathogens [162, 163]. Several 

microbes can synthesize antimicrobial proteins, such as cathelicidins, C-type lectins, inside the 

intestine, thus protecting it from pathogenic microbes [164, 165]. Additionally, certain gut 

microbes, like Lactobacillus, can produce lactic acid inside the intestine, which acts as an 

antimicrobial agent [166]. 
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1.1.4.2 Vitamin B9 and gut microbiota 

 

The human body cannot synthesize vitamins on its own; therefore, dietary intake is the primary 

source of such micronutrients. That being said, gut microbiota can contribute to a certain amount 

of vitamins, as a selected number of bacteria can produce specific vitamins including, vitamin B9 

[147]. Approximately 13.3% of human gastrointestinal bacteria can synthesize B9 de novo, 

whereas 39% can produce this vitamin if pABA, a structural component of folate, is provided 

[167]. Magnúsdóttir et al., predicted that 26% Actinobacteria, 71% Proteobacteria, 79% 

Fusobacteria, and 92% Bacteroidetes can produce vitamin B9 in the gut [5].  

Gut microbiota not only helps us produce vitamins in the gut, but the non-producers also require 

these vitamins for their metabolic reactions [16, 167]. These bacterial cells also use folate to 

perform a variety of biosynthetic processes. Although such cellular reactions are universal, their 

certain biosynthesis pathways may differ from host to host. Organisms such as fungi, plants, 

bacteria, and some specific archaea use a similar folate biosynthetic pathway with slight 

modifications [168]. Several bacteria can produce folate in the gut, including Bacteroides fragilis, 

Prevotella copri, Clostridium difficile, Lactobacillus plantarum, L. reuteri, L. delbrueckii spp. 

Bulgaricus, Streptococcus thermophilus, Bifidobacterium spp (some species), Fusobacterium 

varium, and Salmonella enterica. Bacterial species such as Bifidobacterium are well studied and 

have been categorized based on their folate-producing ability as: high folate producers such as 

Bifidobacterium bifidum and B. longum subsp. Infantis and low folate producers such as B. breve, 

B. longum subsp. Longum and B. adolescentis [169]. Folate synthesis requires pABA and 4-amino-

4-deoxychorismate lyase (EC 4.1.3.38). This enzyme can be found only in the genome of B. 

adolescentis and B. dentium Bd1 as these two can de novo biosynthesis of pABA [170]. Another 

common group of folate-producing bacteria is Lactobacilli. Like Bifidobacterium, Lactobacillus 
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also requires the pABA for folate production. Several Lactobacillus species, for example, L. 

plantarum, L. sakei, L. delbrueckii, L. reuteri, L. helveticus, and L. fermentum can produce 6-

hydroxymethyl-7,8-dihydropterin pyrophosphate (DHPPP) and can synthesize folate in the 

presence of pABA [171]. However, this is not required for other folate-producing genus such as 

Lactococcus and Streptococcus [172].  

1.1.4.3 Vitamin B12 and gut microbiota 

Vitamin B12 is a unique vitamin not found in plants but extensively synthesized by bacteria and 

archaea [173]. Bacteria use either bacterially synthesized corrinoids or from diets to synthesize 

this vitamin in the gut; however, a limited amount of bacterially synthesized vitamin B12 is 

available to the host. This is because the site of production, mostly in colon where microbial 

diversity is highest, differs from the primary site of absorption i.e. the small intestine. [174]. This 

vitamin requires IF to be absorbed and this is found primarily in the small intestine [175]. Some 

gut microbes use the bacterially produced vitamin B12, and ~80% of unused B12 are converted to 

vitamin B12 analogs (mostly cobamides) by transforming them into benzimidazole derivatives [89, 

176]. This gives the gut bacteria the advantage of using vitamin B12 or vitamin B12 analogs for 

their metabolic reactions [174, 177, 178]. 

The biosynthesis of vitamin B12 by microorganism is made possible due to the presence of almost 

30 genes that can function in either aerobic or anaerobic pathways. [179]. Interestingly, 

Lactobacillus spp. does not have the de novo biosynthetic pathway of vitamin B12. However, when 

it converts glycerol into propanediol, it utilizes a pathway that can produce this vitamin [157]. 

Some other microbes produce vitamin B12 from precorrin-2, which is converted into 

adenosylcobalamin but it can not be absorbed into the body at the large intestine [5]. Some vitamin 

B12 producing bacteria include Bacteroides fragilis, Prevotella copri, Clostridium difficile, 
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Faecalibacterium prausnitzii, Ruminococcus lactaris, Bifidobacterium animalis, B.infantis, 

B.longum, Fusobacterium varium [157]. 

1.1.4.4 Bacterial 1C metabolic pathway 

Bacteria also possess the universal 1C metabolic pathway; however, some of the downstream 

metabolic reactions may differ from those of humans. In bacteria, amino acids play an essential 

role in the aminoacylation of tRNA [180, 181], where methionine is used for regulating steps. 

During this process, N-terminal methionine is removed by methionine-aminopeptidase (MAP, EC 

3.4.11.18) [182, 183]. The level of methionine is indirectly regulated by the Cys level and thus 

affects the changes in tRNA [184, 185]. Additionally, 10-CHO-THF, a methyl donor of 1C 

metabolism, is involved in the formylation of methionine-tRNA in the presence of the deformylase 

enzyme (EC 3.5. 1.31) [186].  

1.1.5 Metabolomics: a tool to study nutritional and microbial metabolites 

Modern nutritional research focuses on enhancing our understanding of the impact of nutrients and 

food ingredients on human health [187]. Exploring new biomarkers and pathways represents an 

encouraging step forward in nutritional biochemistry [188]. Existing biomarkers provide valuable 

insights into the consequences of vitamin deficiencies on metabolic processes [189]. However, 

innovative techniques and approaches may be required to gain a deeper understanding of the 

potential pathways affected by nutrient deficiencies. Metabolomics presents an opportunity for 

such exploration [190]. 

1.1.5.1 Metabolomics 

 

Metabolomics is the study of small molecule compounds of biological origin, known as 

metabolites. It aims to identify and quantify metabolites present in a complex biological sample, 
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such as blood, serum, plasma, tissues, and others [191]. It can be regarded as an approach for 

visualizing the biochemical activities within the body [192]. Studying metabolites is highly useful 

as it uncovers valuable biological insights into molecules linked to biological outcomes and their 

potential involvement in various human diseases [193]. Metabolomics is also instrumental in 

identifying important biomarkers that can pave the way towards the discovery of treatment of 

diseases [194].  

1.1.5.2 Methodology in metabolomics 

Metabolomics can be performed on different samples in different approaches and analytical 

platforms [193]. The method can be categorized into targeted and non-targeted approaches. The 

targeted approach is employed to quantify the known metabolites present in the specific sample, 

while untargeted approach is used to identify and quantify all the metabolites present in the sample, 

including the unknown metabolites. Common platforms used in metabolomics studies include gas 

chromatography-mass spectrometry (GC-MS) or liquid chromatography-mass spectrometry (LC-

MS), and nuclear magnetic Resonance (NMR) spectroscopy [195]. One of the most popular 

platforms for untargeted analysis is the use of high-resolution LC-MS-based technology. In this 

platform, all possible metabolites or features are collected in the form of mass-to-charge ratios 

(m/z). The spectrum is then analyzed based on the interest of the specific metabolite/feature, 

enabling the identification of the compound. Characterization and identification can also be done 

by searching through the existing databases [196-198]. 

1.1.5.3 Metabolomics in the study of vitamin B9 and B12 

Metabolomics is being used to study the effect of dietary molecules on human health and disease 

[191]. Studying nutritional metabolomics, sometimes also known as nutrimetabolomics, has been 

proposed to study personalized nutrition [199]. A targeted metabolomics approach has recently 
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been employed to simultaneously detect nine metabolites of the 1C metabolic reaction, providing 

crucial information on how these metabolites change in biological samples subjected to vitamin 

B9 and B12 deficiencies [200].  

The human gut consists of 1015 microbial cells, producing several metabolites in the gut [201]. 

These microbes can also produce various enzymes primarily to support the fermentation of various 

indigestible substrates, such as dietary fibre [202]. This capability results in the production of a 

wide range of products that can be broadly divided into following groups: 1) metabolites produced 

from dietary fibre, and 2) metabolites produced from bile acid [203].  The most extensively studied 

microbial metabolites are SCFAs. The major SCFAs produced by gut microbiota are acetate, 

butyrate and propionate, constituting around 95% of total SCFAs [151, 204]. Acetate is primarily 

produced by enteric microbes such as Lactobacillus spp., Bifidobacterium spp., Bacteroides spp., 

Prevotella spp., Ruminococcus spp., and Streptococcus spp. Common propionate producing 

bacteria are Bacteroides spp., Dialister spp., Salmonella spp., Veillonella spp. and, butyrate 

producing bacteria are Roseburia spp., Clostridium leptum, Coprococcus catus [205-207]. Most 

SCFAs are produced from indigestible carbohydrates, primary dietary fibre and a small amount 

from certain proteins and peptides that contain branched-chain amino acids (BCAAs). Protein and 

peptide-derived BCAA are generally converted to fatty acids such as 2-methylbutyrate and iso-

valerate [208]. The absorption of SCFAs takes place in the colon of the large intestine using either 

hydrogen-dependent or sodium-dependent monocarboxylate transporters [209]. Once absorbed, 

they are used as an energy source in the colon; the rest goes into blood circulation [210].   

1.3 Conclusion 

Micronutrients, especially water-soluble vitamin such as vitamin B9 and B12 play critical role in 

various metabolic processes in human body. 1C metabolism is one of these processes and plays a 
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pivotal role in the interplay between folate and methionine metabolism, where 1C units are 

produced and transferred to support essential biosynthetic pathways. The 1C metabolic pathway 

and its intricate network of enzymatic reactions are crucial for DNA synthesis, gene expression 

regulation, and the maintenance of sulfur-containing amino acids. B vitamins, specifically B9 and 

B12, are an integral part of 1C metabolism and are of particular interest because humans do not 

have the capacity for de novo synthesis. Thus, they must be obtained through dietary intake or 

microbial activity. However, vitamins produced by gut microbiota are not sufficient to meet daily 

requirements of the host, making the diet the primary source of these vitamins. Consequently, 

deficiencies in these micronutrients in the diet will alter the 1C pathway, leading towards metabolic 

diseases.  Although deficiencies of these two vitamins are not very common in developed 

countries, they appear to be a global concern, specifically in developing countries or in association 

with certain health conditions and in older people. Even though the interaction between diet and 

host is well established, the impact of micronutrient deficiency on the host is poorly understood. 

As such, more research is needed to shed the light on how micronutrient deficiency affects gut 

health and its ecology. 
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CHAPTER TWO 

 

Rational, hypothesis and objective 
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2.0 Study rationale 

B vitamins, specifically vitamin B9 and B12, are involved as a cofactor in 1C metabolism. Folates 

provide the crucial intermediate THF required for the folate cycle. This metabolic process is vital 

as it provides 1C groups for numerous enzymatic reactions, including the synthesis of purines and 

pyrimidines as well as oxidative reactions. [12].  Specifically, these micronutrients are essential 

for providing the formyl group required for DNA synthesis and for the conversion of methionine 

to SAM by MAT enzyme in the methionine cycle [14]. However, the precise impact of dietary 

deficiency of these crucial vitamins on the growth and ecology of gut microbes remains unknown. 

Most of the human gut microbiota requires corrinoids, the core nutrient for vitamin B12 synthesis, 

for their growth [178].  Similar to humans, microbial 1C metabolism is also folate and vitamin 

B12 dependent [211]. Therefore, we hypothesized that deficiency of these vitamins will alter the 

1C metabolic pathway, which is critical not only for various metabolic reactions in the host but 

also for the bacteria colonizing in the gut. Consequently, these deficiencies will affect the growth 

and proliferation of gut microbiota and, as a result, its composition. This imbalance in the gut 

ecosystem will lead to changes in the production of various gut metabolites, ultimately affecting 

gut homeostasis.  

2.1 Hypothesis 

A deficiency in either vitamin B9 or B12 will impair the composition of intestinal microbiota and 

gut metabolites, potentially disturbing the balance of gut homeostasis. 

2.2 Overall aim and specific objective 

The overall aim of the work presented in this thesis was to investigate the impacts of dietary 

deficiencies in B vitamins, specifically B9 and B12, on 1C metabolic reactions, intestinal 

morphology, gut microbiota, and gut metabolites. The study focused on the following objectives.  
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2.2.1 Objective 1 

To investigate the effects of dietary vitamin B9 and B12 deficiencies on physical parameters, 

such as body weight, organ weights, intestinal length, colon morphology, and mucin production. 

2.2.2 Objective 2 

To investigate the effects of dietary vitamin B9 and B12 deficiencies on the composition of gut 

microbiota. 

2.2.3 Objective 3 

To investigate the effects of dietary vitamin B9 and B12 deficiencies on serum metabolites linked 

to 1C metabolic pathway using targeted and untargeted metabolomics. 
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CHAPTER THREE 

 

Investigating the roles of B vitamins and one-carbon metabolism in gut homeostasis 
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3.0 Abstract 

Vitamins are the organic compounds essential for normal growth and metabolic processes in all 

living organisms. B vitamins, such as vitamin B9 and B12, act as cofactors in various metabolic 

reactions, including one-carbon metabolism (1C), and are typically required in trace amounts. A 

diverse array of bacteria reside in the gut, and some of these microbes have the capacity to 

synthesis  specific vitamins. These bacteria also require certain vitamins for their growth, with 

requirements varying between vitamin-producing and non-producing strains. Despite the well-

understood functional role of B vitamins, their impacts on gut microbial growth and the production 

of microbial metabolites remain poorly understood. The current study aimed to investigate the 

impacts of vitamin B9 and B12 deficiencies on gut morphology, microbial composition and their 

metabolites. A total of 48 Sprague-Dawley rats were fed either a control diet (n=15), a low B9 diet 

(LB9, n=16), or a low B12 (LB12, n=16) diet for six weeks. Body weights were measured weekly, 

and at the end of the study, blood, tissue, and fecal samples were collected for various biochemical 

analyses. Our results revealed significant sex effects on body weight, liver weight and brain 

weight. Upon separating the sex, we did not find any significant treatment effects. Serum vitamin 

levels were significantly lower (p<0.001) in the respective deficient groups compared to the 

control group, as expected. However, the serum metabolites of 1C metabolic reactions did not 

show significant differences in the deficient groups compared with the control. Histological 

analysis showed a significant longer in mucosal height in the LB12 group (p=0.006) compared to 

the control group. Although there were no significant differences in the total mucin content in the 

colon, we observed a notably lower percentage of acidic mucin (p = 0.02) in both LB9 and LB12 

rats when compared to the control rats. Of particular interest, we observed sex-dependent 

differences in the impacts of vitamin deficiencies on the gut microbial profile. Vitamin B9 
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deficiency altered the abundance of various bacterial genera in males, including Colidextribacter, 

Dorea, Lactobacillus, and Streptococcus, while Blautia was altered in females. Similarly, vitamin 

B12 deficiency altered Dorea, Streptococcus was altered in males, and Blautia, Lachnoclostridium 

and Colidextribacter in females. Furthermore, fecal metabolite analysis revealed that 

concentrations of tryptophan and histidine were lower in LB9 compared to the control, whereas 

hydrocinnamic acid, ethylmethylacetic acid, N,N-diacetylsperodine contents were higher in LB9 

group, while N-acetylneuraminic acid was higher in LB12 group. This study provides evidence 

that deficiencies of vitamin B9 and B12, which are critical for 1C metabolism, may exert sex-

dependent effects on gut morphology, gut microbial composition, and associated metabolites.  

Keywords: vitamin B9, B12, deficiency, gut, microbiota, metabolites 
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3.1 Introduction 

Micronutrients such as vitamins play crucial roles in diverse metabolic processes [1]. B vitamins, 

specifically vitamin B9 and B12, function as co-enzymes and methyl donors in one-carbon (1C) 

metabolism [11]. This shared biological pathway is integral to various physiological reactions, 

including nucleotide synthesis, DNA methylation, and redox balance [9, 10]. Disruption to this 

pathway and its associated metabolites are linked to the development of numerous diseases, 

including cancer, cardiovascular disease, Alzheimer’s disease and others [12, 212].  

While the roles of diet and dietary factors in regulating gut microbial composition are well-known, 

the impact of micronutrient deficiencies on gut ecology remains understudied [3]. In the gut, nearly 

100 bacterial species can produce some of the B vitamins and exchange them symbiotically to 

ensure survival [5]. Biosynthetic pathways for vitamins can vary among species, highlighting the 

existence of genetic variations [157]. However, mutual symbiosis between the gut microbiota and 

the mammalian gut has shaped interdependence between gut and gut microbes. The microbiota’s 

ability to produce essential substances, including vitamins, is significantly influenced by the host 

environment, including availability of substrates. For instance, folate can be produced by several 

bacterial species, including Bacteroides fragilis, Lactobascillus plantarun, and Bifidobacterium 

spp by utilizing para-aminobenzoic acid (pABA) [5, 157]. Whereas bacteria like Pseudomonas 

denitrificans and Bacillus megaterium use bacterially synthesized precorrin-2 for vitamin B12 

synthesis [5]. Furthermore, various taxa have evolved to fulfill specific roles in relation to the 

synthesis and utilization of vitamins [7]. Among all the vitamins synthesized in the gut, riboflavin 

and niacin are the most commonly produced vitamins [5]. Despite the gut microbiota’s ability to 

produce these vitamins, several reasons, such as the production site and competition between host 
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and non-producing bacteria, render the vitamin unavailable or less available to the host [5]. This 

results in dependency on the dietary source to meet daily micronutrient requirements [13]. 

Severe deficiencies of these micronutrients are rare in developed countries, but moderate 

deficiencies are still observed [2]. The prevalence of folate deficiency is under 5% in developed 

countries but much higher in developing countries (closer to 20%) [56]. Although the folate 

deficiency is limited in healthy individuals, Canadian Health Measures Survey (CHMS) indicated 

that 22% of child bearing women showed folate deficiency regardless of their age [57]. On the 

other hand, the epidemiology of vitamin B12 deficiency varies depending on its etiology. Studies 

revealed that approximately 1-2% of individuals with anemia suffer from B12 deficiency. Around 

5% of adults under the age of 60 in Canada, the United States, and the United Kingdom have 

vitamin B12 deficiency, while the prevalence rises to around 20% in individuals over the age of 

60 [106, 107].  

Although severe deficiencies of B9 and B12 are not common, when specific health conditions such 

as pregnancy, physical and metabolic stress, or certain diseases is involved, even moderate 

deficiencies can become problematic. These health conditions increase the requirements of B9 and 

B12, particularly folate, compared to normal conditions [213-216]. Moreover, such conditions are 

always associated with changes in gut microbiota [217]. Therefore, it becomes important to study 

how varying levels of vitamin B9 and B12 affect our metabolic processes in the body, particularly 

gut health. It is highly likely that micronutrients, such as vitamin B9 and B12, play a crucial role 

in modulating the composition and metabolic capacity of the microbiota. Thus, in the current study, 

we investigated the influence of dietary vitamin B9 and B12 on gut homeostasis, focussing on gut 

morphology, microbiota composition, and microbial metabolites using a B9 and B12 deficient rat 

model. 
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3.2 Material and method 

3.2.1 Animals and diet 

A total of forty-eight Sprague–Dawley rats of both sexes (24 females and 24 males) were obtained 

from Charles River Laboratories. The animal protocol was approved by the Institutional Animal 

Care Committee at Memorial University of Newfoundland (MUN) and adhered to the guidelines 

of the Canadian Council on Animal Care. The 4-week-old animals were housed in pairs of the 

same sexes in a humidity-controlled room maintained at 22˚ C with a reverse 12h light-dark cycles. 

After a one-week acclimatization period fed with a standard chow diet, they were randomly 

assigned in a pair of same sexes to AIN-93G-based three diet groups: control group, vitamin B9 

deficient group (LB9) or vitamin B12 deficient group (LB12). The diets were purchased from 

Dyets Inc. (Bethlehem, PA, USA). The control diet is the AIN-93G diet, the LB9 diet is a modified 

AIN-93G-based diet without added vitamin B9 in Vitamin Mix # 318258, and the LB12 diet is 

modified AIN-93G-based diet without added vitamin B12 in Vitamin Mix # 318258. Both the LB9 

and LB12 diets contains traces of vitamin B12 (0.004mg/kg) and vitamin B9 (0.04mg/kg) from 

casein. The diet composition is displayed in Table 3.1.  

At baseline, 4th, and 6th week, fecal samples were collected using autoclaved cages and 

immediately transferred to dry ice before being stored it at -70˚C. The animals were fed ad libitum 

for six weeks with their respective diets. Food intake was measured every three days, and body 

weight was measured weekly. After six weeks, the rats were fasted for 8 hours and euthanized 

under 1-1.2 L oxygen /min mixed with 4-5% of isoflurane. Blood was collected via cardiac 

puncture and centrifuged at 4000 × g for 10 minutes to separate the serum, which was subsequently 

stored at -80˚ C until further analyses. All tissues, including brain, liver, kidney, adipose, gut, and 
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muscle, were collected using the snap-freezing method with liquid nitrogen and stored at -80˚ C 

for further use. Cecal contents were also collected and stored it at -80˚ C for further analyses.  

One male in control group died unexpectedly, thus all statistical analyses were conducted on 

samples collected from forty-seven samples. Some cecal sample were lost during collection, and 

this is indicated whenever appropriate. 

Table 3.1: AIN-93G diet composition 

Ingredients 
Control diet 

(g/kg) 

B9 deficient 

diet (g/kg) 

B12 deficient 

diet (g/kg) 

Casein 200 200 200 

L-Cystine 3 3 3 

Sucrose 100 100 100 

Cornstarch 395.4 395.4 395.4 

Dyetrose 132 132 132 

Soybean Oil 70 70 70 

t-Butylhydroquinone 0.01 0.01 0.01 

Cellulose 50 50 50 

Mineral Mix #210025 35 35 35 

Choline Bitartrate 2.5 2.5 2.5 

Vitamin Mix # 318258 

(no B12 or Folate) 
10 10 10 

Folic Acid Premix 

1mg/gm 
2 -- 2 

Vitamin B12 (0.1%) 2.5 2.5 -- 

 

3.2.2 Vitamin B9 and B12 analysis 

Serum samples were shipped on dry ice to the Nutritional Biomarker Laboratory, University of 

British Columbia (UBC), for folate and B12 analyses. Serum total vitamin B12 concentration were 

quantified on fully automated Abbott Architect Immunoanalyzers. Forty-seven samples were 

measured on the Architect i1000SL (Abbott Laboratories, USA) at BCCHRI Analytical Core for 
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Metabolomics and Nutrition. Serum B9 concentration was measured using a microbiological folate 

assay, employing chloramphenicol-resistant L. casei as a test microorganism, as previously 

described [218, 219].  

3.2.3 Histological analysis 

3.2.3.1 Hematoxylin & eosin (H&E) Staining 

A 0.5 mm-thick section of proximal colon was excised and washed with PBS to remove any 

unwanted fecal matter. Subsequently, it was placed in 10% neutral buffered formalin and stored 

for histological analysis. The samples were prepared by the Histology Laboratory, Faculty of 

Medicine, MUN and visualized using a Zeiss Axiostar Plus Microscope with a OMAX A35180U3 

18MP camera. Muscle thickness, mucosal height, and other histological parameters were measured 

using OMAX ToupView (ver 4.11) software by two individuals who were blinded to the treatment 

groups. The average reading of the two individuals have been used for data analysis. The detailed 

histological protocols are given in Appendix I. 

3.2.3.2 Periodic acid–Schiff and Alcian Blue staining 

Periodic acid-Schiff (PAS) and Alcian blue (AB) staining were conducted with and without 

diastase on the colon section to stain to distinguish different types of mucins. PAS-AB with 

diastase staining used were as a control for proper staining.  Slides were prepared by Histology 

Laboratory, Faculty of Medicine, MUN. Acidic mucin stained blue, neutral mucin stained magenta 

and a combination of both mucins stained as deep purple. The slides were analyzed using Olympus 

BX50WI upright biological microscope with a SC50 Olympus 5-megapixel digital color camera 

and an Olympus uPlanSApo 40x/0.95na lens. Images were captured using CellSens Standard 

software.  Mucin quantification was performed using ImageJ software and color deconvulation2 
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plugin. Mucin contents were expressed in the percentage of total mucin, acidic and neutral mucin. 

The detailed histological protocols are given in Appendix I. 

3.2.4 Gut microbiota sequencing  

Cecal samples were homogenized utilizing a bead-beating homogenizer (MP Biomedicals, 

Lachine, QC, Canada), and genomic DNA was extracted using a FastDNA spin kit (MP 

Biomedicals, Lachine, QC, Canada). The microbial composition was determined by using 

Ilumina’s 16S rRNA gene sequencing of the V3-V4 regions. DNA quantification was performed 

on a Thermo Nanodrop Spectrophotometer. For samples with low DNA content and high salt 

content, de-salting was carried out until a minimum of 10 ng/uL of DNA sample was obtained. 

The samples were stored at -80˚ C before being sent on dry ice for sequencing at Integrated 

Microbiome Resource (IMR), Dalhousie University, NS. Sequencing primers and low quality 

reads were removed using Trimmonatic version 0.39 [220]. A table of amplicon sequence variants 

(ASVs) was generated using DADA2 version 1.28.0 and Silva V138 database using R platform 

version 4.2.1 [221, 222]. Statistical analysis for the microbial data was performed using 

MicrobiomeAnalyst version 2.0. Raw sequence data is available upon request. The detailed 

bioinformatics procedure is given in Appendix II. 

3.2.5 Metabolomics analysis 

3.2.5.1 Targeted serum 1C metabolites analysis. 

Serum targeted 1C metabolites were measured using an LC-MS/MS-based analytical platform 

with the use of isotope-labeled internal standards at the Metabolomics Innovation Centre, 

Edmonton. The analysis also included one blank, three zero samples, six standards (serine, glycine, 

glutamic acid, homocysteine, methionine and betaine), and three quality control samples. Samples 
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were thawed on ice, vortexed and centrifuged at 13,000x g for 10 mins. Subsequently, 10 µL of 

each sample was dried in a stream of nitrogen, and phenyl-isothiocyanate was added for 

derivatization. After incubation, the filtered spots were dried again using an evaporator. The 

derivatized metabolites were extracted by adding 300 µL of extraction solvent. The extracts were 

centrifuged and, if necessary diluted. Mass spectrometric analysis (MS/MS) was conducted using 

an ABSciex 4000 Qtrap® tandem mass spectrometry instrument (Applied Biosystems/MDS 

Analytical Technologies, Foster City, CA) equipped with an Agilent 1290 series UHPLC system 

(Agilent Technologies, Palo Alto, CA).  

3.2.5.2. Untargeted fecal metabolomics 

Fecal metabolomics was performed at The Britz-McKibbin Laboratory, McMaster University. All 

chemical standards and calibrants were purchased from Sigma-Aldrich (St. Louis, MO, USA), 

including analytical grade amino acids, acylcarnitines, ammonium acetate, ammonium 

bicarbonate, ammonium hydroxide, formic acid, organic acids, sodium hydroxide and 

recovery/internal standards: 4-aminobutyric acid-2,2,3,3,4,4-d6 (GABA-d6), choline-d9, 4-fluoro-

L-phenylalanine (F-Phe), 3-chloro-L-tyrosine (Cl-Tyr), fluoro-tyrosine (F-Tyr), trimethylamine-d9 

N-oxide (TMAO-d9), creatinine-d3, 15N2-ornithine, 15N-histidine, carnitine-d3, methylhistidine-

d3, naphthalene monosulfonic acid (NMS) and D-glucose-13C6 (
13C-glucose). All LC-MS grade 

solvents, including acetonitrile, isopropanol, methanol, and water, were obtained from Caledon 

Laboratories Ltd (Georgetown, ON, Canada). Instrumental conditions and data pre-processing 

steps were described previously [223, 224]. Dry stool pellets (10-15 mg), including a pooled 

quality control (QC) sample, were homogenized. A 200 μL of solution containing 4 μM of recovery 

standards in 70% MeOH was added to sample vials. After vortexing, the supernatant was dried 

using nitrogen gas and reconstituted in 40 μL of 70% MeOH containing internal standards (IS). 
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Untargeted analysis was conducted using an Agilent 6230B time-of-flight (TOF) mass 

spectrometer with an electrospray ionization (ESI) source equipped to an Agilent G7100A 

capillary electrophoresis (CE) unit was used for all experiments (Agilent Technologies Inc., 

Mississauga, ON, Canada). The detailed procedures are given in Appendix III. 

3.2.6 Statistical analysis 

All statistical analyses were performed on IBM SPSS statistics (ver 28.0.1.0(142)) and GraphPad 

Prism (9.5.1). Data were normalized with log transformed, and missing data were  replaced with 

mean.  The data were analyzed using  a two-way ANOVA to examine any potential effects of sex, 

treatment, and their interaction. In the case of significant sex effect, data for males and females 

were analyzed separately and if no significant sex effect is observed, then data is presented as one-

way ANOVA. The least significant difference (LSD) post hoc test was used to analyze the 

treatment differences. Microbial data with a minimum of 4 counts were included in the data 

analysis and bacterial species having zero abundance with a minimum of 20% of samples were 

removed from the analysis. Statistics for microbial composition, such as alpha and beta-diversity 

was analysed to study the evenness and richness of the gut bacteria using Microbiomanalyst 

version 2.0.. We analyzed the fecal metabolite data using MetaboAnalyst version 5.0. Metabolite 

data were normalized with quality control samples, followed by square root, and mean centering 

methods. Partial least square discriminant analysis (PLS-DA) was performed, and model 

validation was conducted using R2 and Q2 test with the fivefold cross-validation method at p < 

0.05. For all other analyses, p < 0.05 was considered statistically significant. 
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3.3 Results 

3.3.1 B9 and B12 deficiency exerted sex differences in their physical parameters 

We found a significant sex effect on the body weight (p<0.001), liver (p=0.034), and brain weight 

(p<0.001), but no treatment and interaction effects (>0.05, Appendix IV). Similarly, we also found 

significant sex differences in body weight adjusted duodeno-jejunal length (p<0.001) but did not 

find any significant treatment effects after separating males and females.  Duodeno-jejunal length 

(34.07±4.35) of females was significantly (p<0.001) longer than males (20.52±1.63). We also we 

did not find any significant sex and/or treatment effects on ileum (p= 0.67) or colon length (p= 

0.96) (Appendix IV). 

3.3.2 Serum vitamin B9 and B12 concentration differs among the treatment groups 

Serum B9 concentration was significantly lower in LB9 group (15.4±11.0 nmol/L) compared to 

control (103.0±17.6 nmol/L) (p< 0.001) (Figure 3.1 A). Similarly, serum B12 level was 

significantly lower in LB12 group (187.7±36.73 pmol/L) compared to control (478.9±119.99 

pmol/L) (p< 0.001) (Figure 3.1 B). However, we did not find any sex and interaction effects 

(>0.05) on serum B9 and B12 level. 
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Figure 3.1: Serum vitamin B9 (A) and B12 (B) concentrations after six weeks of exposure to 

vitamin-deficient diets. abGroups with different letters are significantly different by one way 

ANOVA-test. Values are expressed as mean ± SD, n= 16 in LB9 and LB12 and n= 15 in control. 

3.3.3 Serum 1C metabolites were not affected by B9 and B12 deficiency. 

Serum 1C metabolites were analyzed using targeted approach by using LC-MS/MS method. No 

significant differences were measured for the six metabolites associated with 1C metabolism when 

animals were exposed to vitamin B9 and B12 deficient diets for six weeks (Table 3.2). However, 

serum glycine level (p=0.002) and methionine level (p=0.004) have sex effects but no treatment 

and interaction effects (>0.05) on any of the metabolites. 

Table 3.2: Serum 1C metabolites concentrations by treatment groups.   

 Metabolites (μM) Control LB9 LB12 P-value 

Betaine  105.14±33.65 98.7±39.55 101.06±33.15 0.61 

Glutamic acid  123.37±69.40 113.1±35.91 112.03±39.87 0.79 

Glycine  236.76±97.97 186.69±45.34 229.11±83.31 0.16 

Homocysteine 5.79±0.57 6.05±0.68 6.1±0.87 0.35 

Methionine  58.26±12.22 51.68±10.99 59±15.83 0.24 

Serine 324.11±60.33 315.56±46.81 299.25±49.40 0.28 

Values are expressed as mean ± SD, n= 16 in LB9 and LB12 and n= 15 in control. 
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3.3.4 Histological analyses 

3.3.4.1 Vitamin B12 deficiency increased colon mucosal height 

There was significantly greater (p = 0.006) mucosal height in the colon in the LB12 group 

compared to the control group (Figure 3.2). However, we have seen a trend in being significant in 

wall thickness (p= 0.07) and muscle thickness (p= 0.08); we did not find any significant differences 

in submucosal thickness (p= 0.11) and crypt height (p= 0.44). The gut physical parameters with 

their mean values are listed in Table 3.3. 

 Table 3.3: Histological analysis using H&E staining showing mucosal height is significantly 

different in LB12 compared to the control.  

Parameters (mm) Control LB9 LB12 p-value 

Wall Thickness 1.65±0.43 1.92±0.29 1.96±0.28 0.07 

Muscle Thickness 0.87±0.3 1.09±0.21 0.99±0.19 0.08 

Submucosal Thickness 0.22±0.1 0.27±0.09 0.3±0.1 0.11 

Mucosal Height 0.18±0.03a 0.18±0.03a 0.2±0.02b 0.006 

Crypt Height 0.54±0.13 0.5±0.11 0.56±0.07 0.44 

 abGroups with different letters in the row are significantly different by one way ANOVA-test. 

Values are expressed as mean ± SD, n= 16 in LB9 and LB12 and n= 15 in control. 

 

Figure 3.2: Representative examples of histology image showing the difference in mucosal height 

(A) with corresponding bar graph (B). The yellow arrows show how measurement were taken in 

the colon H&E section. The length was measured from two mucosal folding and from the top of 

the submucosal layer to the top of mucosal area using OMAX ToupView (ver 4.11). All the 
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measurement were taken in mm. The mucosal height of the LB12 was significantly higher 

(p=0.006) (0.22±0.02 mm) compared to control (0.18±0.03 mm), and LB9 (0.18±0.03 mm) group. 
ab Groups with different letters are significantly different by one way ANOVA-test. Values are 

expressed as mean ± SD, n= 16 in LB9 and LB12 and n= 15 in control. 

3.3.4.2 LB9 and LB12 significantly decreased acidic mucin in the colon 

 

There were no significant differences in percent area for content of total mucin content (p=0.83) 

or neutral mucin (p= 0.94). However, interestingly, we found a significantly lower (p = 0.02) in 

the percentage of content of acidic mucin in both LB9 and LB12 groups compared to the control 

group (Figure 3.3)  

 

Figure 3.3: Representative PAS-AB-stained gut histology images showing different mucins (A) 

with their corresponding bar graphs (B) (p= 0.02). The figures are represented as % of the area of 

the slides. The ImageJ software was used to quantify total (purple), acidic (blue) and neutral 

(magenta) mucins using color deconvulation2 plugin. abGroups with different letters are 

significantly different by one way ANOVA-test. Values are expressed as mean ± SD, n= 16 in LB9 

and LB12 and n= 15 in control. 
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3.3.5 Vitamin B9 and B12 deficiency altered gut microbial composition in sex-dependent 

manner 

We detected 1562 ASVs in our sample. After screening the data manually and removing ASVs 

which had 0 abundances in 70% of the total samples, we had 94 ASVs that we considered for data 

analysis. Alpha and beta diversity was examined to study the richness and composition of the gut 

bacteria, but we did not find any significant changes in terms of Shannon index (Figure 3.4 A, 

p=0.69), and PCoA analysis (Figure 3.4 B, PERMANOVA p=0.27). Although the relative 

abundances of Verucombimicrobiota in LB12 seemed to be different from the control and LB9 

group at phylum level (Figure 3.4 C, p=0.2) but at genus level (Figure 3.4 D, p=0.06), there were 

no significant differences among the treatment groups.  
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Figure 3.4: Cecal microbiota showing Shannon index alpha-diversity (A), PCoA plot (B), Relative 

abundance of the bacteria at phylum level (C) and genus level (D). There were no significant 

differences in alpha diversity, no significant separations of the bacteria in different treatment 

groups and no significant changes in the relative abundances of the bacteria at phylum and genus 

levels. Values are expressed as mean ± SD, n= 11 in control, n=14 in LB9, and n=15 in LB12.   
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Interestingly, there was a significant sex effect on the richness and evenness (Shannon index, 

p=0.05, Figure 3.5 A), as well as compositional differences (PCoA beta diversity, PERMANOVA 

p=0.001, Figure 3.5 B) of the gut microbial profile. Figure 3.5 C shows the microbes responsible 

for the separation between the sexes, which include Akkermansia, Balutia, Bacteroides, 

Parasutterella, Adlercreutzia, Christensenellaceae_R_7_group, Marvinbryantia, Dorea, 

Romboutsia. Thus, we further analyzed the gut microbial data to investigate treatment effects by 

segregating the data based on sex.  
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Figure 3.5: Gut microbial profile showing alpha diversity by Shannon’s index (A) and beta 

diversity as PCoA (B) showing distinct microbial composition between males and females of 

microbial data based on sex. Gut microbiota was significantly different between the males and 

females when measured in Shannon’s index (p<0.05) and PCoA analysis (PERMANOVA 

p=0.001). n=20/group for females and n=21/group for males. Major bacteria responsible for 

separating between the sexes have been identified by their Linear Discriminant Analysis (LDA) 

score (C).   
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Impact of vitamin B9 and B12 deficiencies on microbial profile of male rats  

In the male rats, the microbial diversity, based on Shannon index ( diversity) and PCoA analysis 

(β diversity), did not show significant separation between the treatment groups (Figure 3.6 A and 

B). To examine significant bacteria, we conducted an additional analysis using linear discriminant 

analysis (LDA) effect size (LEfSe), comparing each treatment groups with the control. Significant 

bacteria were identified based on the LDA scores and their corresponding p-values. The bacterial 

profiles did not differ at the phylum level (Figure 3.6 C); however, at family level, the abundances 

of Lactobacillaceae (p=0.003) and Streptococcaceae (p =0.02) were comparatively lower, whereas 

Ruminococcaceae showed an increase (p=0.02) in LB9 group compared to the control. Conversely, 

the abundances of both Micrococcaceae (p =0.04) and Streptococcaceae (p=0.05) were decreased 

in LB12 compared to the control. At the genus level, we observed a significant reduction in the 

abundance of Dorea and Lactobacillus in LB9 group, while the abundance of Strepcococcus was 

significantly reduced in both LB9 and LB12 groups compared to the control (Figure 3.7: A-C). 
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Figure 3.6: Cecal microbiota does not show any significant differences between alpha diversity 

(Shannon index, p=0.23) (A), PCoA plot (B), and relative abundance of the bacteria at phylum 

level (C). There were no significant differences in alpha diversity, no significant separations of 

the bacteria in different treatment groups and no significant changes in the relative abundances 

of the bacteria at phylum levels. At genus levels, abundance of Colidextribacter, Lactobacillus, 
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Streptococcus and Dorea were significantly altered (D). Values are expressed as mean ± SD, 

n= 5 in control, n= 8 in LB9 and LB12.   

 

Figure 3.7: Abundance of altered bacterial genera using 16S rRNA gene sequencing in males. 

Three genera i.e Lactobacillus, Streptococcus and Dorea were significantly altered in males. 

Streptococcus showed a significant decrease in both the treatment group (A), Lactobacillus 

showed a significant decrease in LB9 (B), and Dorea showed a decrease in LB9 group (C). Values 

are expressed as mean ± SD, in males, n= 5 in control, n= 8 in LB9 and LB12 and in females, n= 

6 in control, n= 6 in LB9 and n= 7 in LB12. 

Impact of vitamin B9 and B12 deficiencies on microbial profile of female rats  

Similar to the male rats, there were no significant separation of microbial diversity between the 

treatment groups in the female rats (Figure 3.8 A and B). The LEfSe analysis revealed that the 

abundance of Bacteroidota was significantly lower in LB9 group compared to the control group 

(p=0.05), but no significant difference was found for LB12 group at the phylum level (Figure 3.8 

C).  There were no changes observed for LB9 group at family level, but Anaerovoracaceae was 

significantly lower (p=0.004) in the LB12 group compared to control. At genus level, 

Lachnoclostridium was significantly decreased in LB9 group compared to control, whereas 

Blautia was significantly increase in both the LB9 and LB12 groups compared to the control 

(Figure 3.9: A & B). 
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Figure 3.8: Females gut microbiota did not show significant separation between the treatment 

groups based on alpha diversity (Shannon index, p=0.68) (A), PCoA analysis (B), and relative 

abundance of the bacteria at phylum level (C). At genus levels abundance of Colidextribacter, 

Lachnoclostridium and Blautia was significantly altered (D). Values are expressed as mean ± 

SD, n= 6 in control, n= 6 in LB9 and n= 7 in LB12. 
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Figure 3.9: Abundance of altered bacterial genera using 16S rRNA gene sequencing in females. 

Two genera i.e Lachnoclostridoum (A) showed significant decrease in LB9 group where as  

Blautia (B), were significantly increased in LB9 group in females. Values are expressed as 

mean ± SD, n= 6 in control, n= 6 in LB9 and n= 7 in LB12. 

We identified one significant bacterial genus, Colidextribacter, which was found to be common in 

both males and females. In males, the abundance of Colidextribacter significantly increased in 

LB12 compared to the control (Figure 3.10 A). In females, the abundance of Colidextribacter 

showed a significant decrease in LB12 group compared to the control (Figure 3.10 B). 
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Figure 3.10: Colidextribacter showed significant alteration in both the sexes, but degree of 

alteration differs between the groups and genera. In males, abundance of Colidextribacter is 

significantly higher in LB12 group when compared with control (A). Whereas in females, it 

showed a significant decrease in LB12 group when compared with control (B). Values are 

expressed as mean ± SD, in males, n= 5 in control, n= 8 in LB9 and LB12, and in females, n= 6 in 

control, n= 6 in LB9 and n= 7 in LB12. 

3.3.6 B9 and B12 deficiencies altered fecal metabolites in a sex dependent manner 

A total of 86 fecal metabolites were identified, along with their peak intensities, using targeted and 

untargeted metabolomics. The data were further screened using MetaboAnalyst version 5.0, and 

metabolic features containing more than 20% of ‘0’ values of the total samples were removed. The 

data were normalized using quality control (QC) samples and autoscaling. Figure 3.11 shows the 

score plot of the principal component analysis (PCA) analysis and its biplot. The PCA represents 

a total of 45.9% variations, with PCA 1 accounting for 30.2% and PC2 for 15.7%. We did not find 

any significant separation among the treatment groups (Figure 3.11). We also conduced Partial 

leased Square-discriminant analysis (PLS-DA), but the cross-validation of the model was not 

significant, indicating that the metabolites abundances were not different. 
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Figure 3.11: PCA score plot (A) and its biplot (B) of fecal metabolites identified by targeted and 

untargeted approach. Ellipses represent 95 % confidence intervals for each individual group on 

PCA plots. n= 15 in control, n= 16 in LB9 and LB12. 

We further investigated sex effect on the fecal metabolite profile. Figure 3.13 illustrates the PLS-

DA score plot colored by sex (Figure 3.12 A) and variable importance of projection (VIP) score 

plot (Figure 3.12 B). PC 1 represents 29.2%, and PC 2 represents 11.3% of the variation, 

accounting for a total of 40.5% of variation. Interestingly, the treatment groups were separated 

based on the sex, indicating a difference in the metabolite concentration between the sexes. 

Important metabolite identified by VIP scores that drives the separation includes phenethylamine, 

lactic acid, gluconic acid, ethylmethyl acetate, desaaminotyrosine and glucuronic acid. 
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Figure 3.12: Fecal metabolite shows significant separation between sex in PLS-DA plot (A). 

Ellipses represent 95 % confidence intervals for each individual group on PLS-DA plots with Q 2 

=0.42 and R 2 =0.52. VIP scores reflect the degree of importance of a metabolite that might be 

responsible for this significant separation between males and females (p = 0.02), with values >1.0 

is considered as important metabolites responsible behind the separation (B).  n=24 in females and 

n=23 in males. 

As we observed a significant separation of fecal metabolites between the sexes (Figure 3.12), we 

further analysed the treatment effects by separating the data based on sex (Figure 3.13). However, 

there was no significant separation between treatment groups in the PCA score plot for both males 

(A) and females (C). The PCA analysis in males represent a total of 55.4% variations, with PCA1 

accounting for 39.6% and PCA 2 accounts for 15.8% in males (Figure 3.13 A). In females, the 

PCA analysis represents a total of 40.2% variations, with PCA1 accounting for 20.6% and PCA 2 

accounts for 19.6% in females (Figure 3.13 C). Figure 3.13 B, D illustrate the biplot of the PCA 

analysis. 
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Figure 3.13: PCA plot in males (A) and in females (C) showed no significant separation between 

treatment. Biplot showing possible metabolite that might be contributing towards the separation 

between males (B) and females (D). 

Next, we performed a volcano test to examine whether the metabolites identified for each treatment 

group were different from control. Interestingly, we found that tryptophan and histidine were lower 

where as hydrocinamic acid, ethylmethylacetic acid, and N,N-diacetylsperodine  were higher in 

LB9 group compared to the control group (Figure 3.14 A). Similarly, N-acetylneuraminic acid and 

three other unidentified compounds were higher in LB12 group when compared with the control 

(Figure 3.14 B). 
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Figure 3.14 Volcano plots showing the significant metabolites in LB9 (A) and LB12 (B) groups. 

Metabolites with log2 fold change with p<0.05 were considered significant. Significant 

metabolites higher in LB9 groups are hydrocinnamic acid, N,N-diacetylsperodine and 

ethylmethylacetic acid whereas tryptophan and histidine is lower. On the other hand, N-

acetylnuraminic acid and some unknown metabolites were higher in LB12 group.  n=15 in control 

and n= 16 in LB9 and LB12. 

3.4 Discussion 

 

B vitamins, including B9 and B12 play important roles in human metabolism as co-factors for 

biochemical reactions, primarily linked to 1C metabolism [126]. Essential B vitamins can be 

obtained through dietary intake or synthesized by bacteria residing in the gut. Nevertheless, only 

a limited number of gut bacteria have the ability to produce B vitamins [3, 225]. Thus, these 

microbes along with host heavily rely on diet sources of these vitamins. However, there is limited 

knowledge regarding how diet-derived vitamin B9 and B12 interact with the gut morphology, 

microbiota and metabolites. Thus, the primary focus of the current investigation was to analyze 

the potential effects of insufficient dietary vitamin B9 and B12 on gut health, specifically, indices 

of gut morphology, microbial profile and the metabolites produced by the host and the gut 

microbiota. The findings from our study provide evidence that a deficiency in dietary vitamin B9 

and B12 led to an alteration in gut health. 
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There were significant sex differences in the body weight among groups, but there was no 

treatment effect, which is contrary with a previous B6 study [226]. We also found significant sex 

differences in brain and liver weight after adjusting with body weight. However, there was no 

treatment effect on males and females separately. Alterations of intestinal morphology due to 

disease are well documented, for example with such as short bowel syndrome (SBS), deeper colon 

crypt were observed [227]. While there is less information on the impact of dietary vitamin 

deficiency on intestinal morphology, Berg and colleagues reported that patients suffering from 

vitamin B12 and B9 deficiency had shorter but broader villi in duodeno-jejunal area [228]. To our 

knowledge, morphological changes and specifically colon mucosal height differences due to 

dietary vitamin deficiency has not been reported yet. However, there is evidence that, in the event 

of B12 deficiency under diseased conditions, colon length was shortened when compared with a 

healthy mouse model [229]. In rats, B vitamin deficiencies led to an almost 50% reduction in 

colonic area (length X width) [230]. Overall, these studies suggest that intestinal morphology 

changes with intestinal disease and vitamin deficiency conditions.  

Mucin, a glycoprotein secreted mainly by epithelial and goblet cells plays a crucial role in 

protecting and lubricating intestinal membranes [231]. It also facilitates communication between 

external environment and epithelial cells through cellular signaling [232]. Mucins can be acidic or 

neutral based on constituents of the glycoproteins. Acidic mucin, primarily found in the large 

intestine, is believed to defend against bacterial invasion due to its less degradable sulfated 

constituent [233]. Diet composition may play an important role in mucin production. For instance, 

heteroxenic rats on an inulin enriched diet showed reduced colonic acidic mucin compared to 

control rats [234]. Another study provided evidence that, butyrate level up to 5mM can increase 

mucin production. But over  5mM concentration can cause a gradual decrease the mucin 
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production in the gut [235]. In our study, we found decreased acidic mucin in both LB9 and LB12 

groups. Colon mucin production is influenced by various factors, including diet, microbes, and 

microbial metabolites [236]. As such, low levels of B9 and B12, altered bacterial composition, and 

lower levels of serum glycine likely played significant roles in reducing acidic mucin levels in 

LB9 and LB12 rats. 

Deficiency in vitamin B9 or B12 resulted in sex-specific alterations in the gut microbiota and 

associated metabolites; this was an unexpected outcome. One of the interesting findings of our 

current study was the alteration of Colidextribacter in both the sexes but it showed a fully opposite 

treatment effect in males and females. Colidextribacter is a recently characterized bacterial genus 

that belongs to phylum Firmicutes and family Oscillospiraceae [237]. It is predominantly found in 

males and is heavily influenced by diet [238]. In addition, we found that the abundance of 

Lachnoclostridium decreased in LB9 while the abundance of Blautia increased in both the LB9 

and LB12 group in females. Lachnoclostridium is a known butyrate producer [239]. Thus, 

decreased abundance of Lachnoclostridium might have led to lower butyrate production in the 

current study. Lachnoclostridium is a B9 producer and synthesizes vital enzymes required in the 

folate metabolism according to Kyoto Encyclopedia of Genes and Genomes (KEGG) (pathway 

number: 00790 and 00670 for folate biosynthesis and one carbon pool by folate respectively) [240-

242]. On the other hand, Blautia which earlier was thought to be a member of Ruminococcus, is 

also a putative propionate and butyrate producer and a higher abundance of Blautia is associated 

with obesity which includes inflammation and insulin resistance [243-245]. Previous studies also 

found a relation between Blautia, and a micronutrient, vitamin D [246]. This implies that, Blautia 

can be affected in response to micronutrient deficiency.  In males, Lactobacillus, Streptococcus, 

and Dorea were altered in response to the B9 and B12 deficiencies. Lactobacillus is a vitamin B9, 
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B12 and butyrate producer, while Dorea is also a putative butyrate producer [247-249]. Another 

bacterial genus, Streptococcus that was decreased in both the group is also a butyrate producer 

[250]. Even though we found several butyrate producers were decreased in the gut, there could be 

other genera utilizing diet constituents to regulate secretory function of colonic goblet cells. 

Hydrocinnamic acid is an organic compound, also known as phenylpropanoic acid, and is 

generally found in kidney, liver, and several microorganisms [198]. Hydrocinnamic acid is thought 

to be a product of phenylalanine which is produced  by gut microbiota and mostly found in feces 

[251]. In our study, we found that, in LB9 group, hydrocinnamic acid was higher compared to 

control which suggests that phenylalanine utilization capabilities of gut microbiota or abundance 

of microbes that were utilizing phenylalanine, might have been increased. Another metabolite 

found in feces at higher level in LB9 group was N,N-Diacetylsperodine. N,N-Diacetylsperodine 

is a kind of polyamine that it found in all organisms and is known to have several functions related 

to cell growth and regulation, nucleic acid regulation and others [252-254]. Recent studies have 

found that concentration of this polyamine is higher in the blood and liver of patients with 

colorectal, and breast cancer and in inflammatory bowel disease [255-257]. These polyamines are 

synthesized by S-adenosyl-methionine decarboxylase from SAM, and SAM is a crucial 

intermediary metabolite of 1C pathway [258, 259]. Interestingly, Lactobacillus can produce this 

polyamine in the gut [260, 261].  This polyamine is positively related to folic acid but it is inversely 

related to dietary folate intake, which is consistent with previous findings B9 [262] and our 

findings of higher N,N-diacetylsperodine in LB9 group. Even though folate is an essential nutrient 

to synthesize polyamide, surprisingly their concentration is not decreased significantly in a folate 

deficient environment, which might be a result of a compensatory response [263]. 

Ethylmethylacetic acid or 2-Methybutyric acid (HMDB0002176) has been found in higher 



66 

 

concentrations in LB9 group compared to control. Ethylmethylacetic acid is a metabolite found in 

Lactobacillus lactis and generally found during carbohydrate starvation [264]. In our study, we 

found in LB9 group, Lactobacillus was significantly lower in comparison with control. It might 

be possible that carbohydrate utilization in the event B9 deficiency has been disrupted, but this 

needs further clarification. On the other hand, lower metabolites in LB9 are tryptophan and 

histidine. Tryptophan metabolism is solely dependent on several B vitamins which includes B6, 

B9 and B12 [265]. Interestingly, gut tryptophan concentration was significantly higher in germ 

free mice compared to conventional ones most likely due to the lack of tryptophan degrading 

microbiota [266]. This intricate relation of tryptophan, folate and tryptophan degrading microbiota 

might be the reason for lower level of tryptophan in our study. On the other hand, histidine 

catabolism is folate dependent, and folate deficiency leads towards an increased urinary secretion 

of histidine [267, 268]. This might be the reason why we found lower levels of histidine in folate 

deficient rats.  

We found an upregulation of N-acetylneuraminic acid in LB12 compared to the control. N-

acetylneuraminic acid, a member of sialic acid group, is one of the components of mucin [269]. 

Kiran et al., 2023 reported that, an increase in total serum sialic acid and lipid bound sialic acid in 

B12 deficient children which was associated with elevated oxidative stress and inflammation 

[270]. There are other members of sialic acid, and N- acetylneuraminic acid is one of them [271]. 

It is possible that the increase in N-acetylneuraminic may lead to the failure to activate and 

incorporate it into the mucin synthesis in B12-deficient animals. Figure 3.15 illustrates the overall 

effects of B9 and B12 deficiency on 1C metabolic reaction and gut homeostasis. 
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Figure 3.15: Overview of the impacts of B-vitamin deficiency on one-carbon (1C) metabolism and 

gut homeostasis: Deficiencies in vitamins B9 or B12 led to reduced acidic mucin content and 

increased mucosal height in the colon. This was associated with a reduced glycine level, a 1C 

metabolites, and alterations in specific gut microbiota and metabolites in a sex-dependent manner. 

Figure is generated with BioRender. 

 

3.5 Conclusion 

 

Microbially produced vitamins are not enough for the host to meet its daily requirements thus, 

dietary supply is essential. We observed that deficiencies of B9 and B12 resulted in a sex dependent 
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alteration in the intestinal length, with females being more susceptible to both the deficiencies. 

Additionally, B12 deficiency increased colon mucosal height, but it decreased acidic mucin 

production in both sexes. In our study, we identified changes in the gut microbiota composition, 

with sex-specific variations. Colidextribacter, a genus associated with diet, showed opposing 

treatment effects in males and females. Hydrocinnamic acid, N,N-Diacetylsperodine, and other 

metabolites changed as a result of the treatment, revealing information about the capacity of 

protein fermentation and polyamine synthesis. N-acetylneuraminic acid, a component of mucin, 

was elevated in response to B12 deprivation, whereas tryptophan and histidine levels were 

decreased. 

Our work demonstrates the complex interactions between B9 and B12, the gut microbiota, and gut 

health. Dietary deficits of certain B vitamins can affect metabolite profiles and gut microbiota 

composition differently depending on sex. Understanding these interactions might play a crucial 

role in dietary interventions to maintain and improve gut health in future. 
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CHAPTER FOUR  

 

Summary, and key findings 
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4.0 Summary  

 

This thesis focused on exploring novel roles of dietary micronutrients on gut morphology, 

microbes, and metabolites and how they interact to maintain gut homeostasis. B vitamin, 

specifically B9 and B12 acts a co-factor for 1C metabolic pathway [14]. Humans cannot synthesize 

these water-soluble vitamins and must obtain them primarily through dietary intake, although a 

limited amount is produced by the gut bacteria [272].  Thus, we hypothesized that dietary 

deficiency of these two vitamins will impair the 1C metabolic pathway and alter the host gut 

ecosystem through a change in gut microbiota and production of their metabolites.  

Contrary to our previous findings on the effect of vitamin B6 deficiency, we did not find any 

significant differences in terms of body growth and organ weights between the groups. This might 

be the result of the inability to induce vitamin deficiency at the host physiological level. It is 

supported by our findings that, although serum B9 and B12 levels are lower, most of the 

metabolites linked to 1C pathway did not change. One of the most significant findings of our study 

was the reduction in acidic mucin content of colon in vitamin-deficient groups. Acidic mucin is a 

type of mucin that acts as a protective layer against pathogens [273]. Interestingly, we also found 

an alteration of serum glycine and fecal N-acetylneuraminic acid levels, which are known to be 

involved in mucin synthesis. 

 The next important finding was the sex-dependent alteration of the gut microbial profile in 

vitamin-deficient groups. Cecal microbiota analysis revealed that the microbes were altered in a 

sex-dependent manner. For instance, in males, genera such as Dorea, Lactobacillus and 

Streptococcus were altered, but in females Blautia and Lachnoclostridium were altered in folate-

deficient animals. One genus, Colidextribacter, was common in both sexes, but the degree of 

change was completely opposite between the sexes. Fecal metabolomics revealed that tryptophan 
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and histidine were lower, whereas hydrocinamic acid, ethylmethylacetic acid, N,N-

diacetylsperodine is higher compared to control in folate-deficient animals. On the other hand, N-

acetylneuraminic acid was higher in vitamin B12-deificient animals. Thus, our data provide 

evidence that vitamin B9 and B12 affect gut morphology, microbiota, and their metabolites 

differentially in a sex-dependent manner. 

4.1 Key findings  

 

1. Body and organ weight: Vitamin B9 and B12 deficient diet did not cause any significant 

difference in body weight and organ weight. 

2. Intestinal morphology: Duodeno-jejunal length adjusted with body weights showed a 

significant sex difference. Rats in LB12 group had significantly higher colon mucosal 

height, but not those in the LB9 group. 

3. Mucin production: Total mucin and neutral mucin in % area were not significantly altered, 

but acidic mucin was significantly decreased in both groups. 

4. Microbiota: Microbes were altered in a sex-dependent manner. In males, genera such as 

Dorea, Lactobacillus and Streptococcus were altered, while in females, Blautia and 

Lachnoclostridium were altered. One genus, Colidextribacter, was commonly affected in 

both sexes, but the degree of change was completely opposite between the sexes. 

5. Metabolites: In LB9 group, tryptophan and histidine were lower, whereas hydrocinamic 

acid/phenylpropanoic acid, ethylmethylacetic acid, N,N-diacetylsperodine were higher 

compared to control. Similarly, in LB12 group, N-acetylneuraminic acid was higher. 
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4.2 Limitations 

 

In this study, the dietary vitamin deficiency treatments result in a marginal level of vitamin 

deficiencies. Even though animals will have a negligible amount of the two vitamins in their 

deficient diets, previously stored vitamins, specifically vitamin B12, which can be stored in the 

body for up to six months, might have worked to buffer the deficiency at the physiological level. 

The coprophagy nature of animals is one way to obtain these vitamins.  A study by Sukemori et al. 

2006 revealed that B12 intake through coprophagy could provide a similar vitamin B12 level as 

that of a B12-supplemented diet [274]. Preventing coprophagy is a stressful event for the animals 

but could be something to consider in such experimental designs. 

4.3 Conclusion 

 

This study sheds light on the effects of B9 and B12 deficiency on gut health. Our finding revealed 

that vitamin deficiencies altered gut morphology, including increased mucosal height and 

decreased acidic mucin production. Sex-dependent alterations in microbial composition revealed 

changes in the abundance of certain vitamin and SCFA producing bacteria, including 

Lachnoclostridium, Lactobacillus, Colidextibactor, and Blautia. Although serum metabolites of 

1C pathway were not affected by the vitamin deficient diets, changes are observed in their fecal 

metabolites. Overall, this study provides crucial insights into the significant role that B vitamins 

play in maintaining gut homeostasis.  
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APPENDIX I 

Histological analysis 

H&E staining 

For H&E staining, we have used Mayer's haematoxylin and eosin method. 

Procedure: 

 1. De-paraffin slides in xylene for 3-5 min.  

 2. Rehydrate by placing in decreasing concentrations, Absolute, 95%, 80%, 70%, for 2 min. 

each.  

 3. Rinse in water 1 min.  

4. Stain in Mayer's haematoxylin for 20-30 min. 

 5. Rinse in water 

 6. Place in STWS for a 3min. until sections are blue. 

 7. Rinse in water for 5 minutes. 

 8. Stain in Eosin 15 sec.-2 min. 

 9. Dehydrate quickly in 95%, and absolute alcohol. 

10. Clear in xylene and mount. 

Periodic acid–Schiff (PAS) and Alcian Blue (AB) staining 

PAS-AB staining was performed on the colon section to stain the mucin in the colon. Slides were 

prepared by Histology department, Faculty of Medicine, MUN. Acidic mucin was stained blue, 

neutral mucin were stained magenta and combination of both mucin was stained as blue/deep 

purple. Slides were analyzed using Olympus BX50WI upright biological microscope with a SC50 

Olympus 5-megapixel digital color camera and an Olympus UPlanSApo 40x/0.95na lens and 

pictures were taken using CellSens Standard software. To quantify the mucin, the first step is to 

set the scale. To set the scale, we need to open Image J and go to Analyze>Set Scale. In the length 

of the line selection (219 pixels) is automatically entered as the "Distance in Pixels". Click the line 

on the panel and use this to measure the distance of scale bar on the picture. ". Enter the scale bar 
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length (50 µm) as the "Known Distance" and "um" as the "Unit of Length". ImageJ will 

automatically convert the "u" to the micrometer symbol (µ). Click "OK". 

 

 

Figure 5.1: Setting scale for measurement of mucin. 

Then next step is to set the RGB. For that, open Image>Type>RGB Stack command to split the 

image into red, green and blue channels. Use green channel for this quantification. Then go to 

Image>Adjust>Threshold tool only works with grayscale images. Try to threshold an RGB image 

and you will get a lot of beeps and the status bar message "RGB images cannot be thresholded". 

Move the slider to view each of the channels. Notice that the green channel has the best separation. 

Use the Image>Stacks>Make Montage command to view all three channels at the same time (not 

necessary unless you want to compare between three types). Select the RGB stack (with the Green 
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channel selected) and press shift-t (Image>Adjust>Threshold). The "Threshold" tool opens and 

the the green channel is automatically thresholded. Unfortunately, ImageJ is not able to correctly 

threshold this image so the threshold must be manually adjusted. Do this by moving the the lower 

slider until the stained collagen is highlighted in red. 

 

   

Red Green Blue 

Figure 5.2: Using RGB stack of ImageJ to measure mucin 

A crucial step is to erase scale bar. To do that, use the rectangular selection tool to select the scale 

bar, then press Backspace (Delete on the Mac). If the current background is not white, use the color 

picker tool (Image>Color>Color Picker) to change it to white. Note that the current background 

color is indicated by the color, which is on bottom, in this case, its white. If you select with 

rectangle, pressing backspace will result in a white color background.  



94 

 

  

Figure 5.3: Preparation of image to remove artifacts from the picture  

To quantify the mucin, go to Analyze>Set Measurements dialog and checking "Area", "Area 

Fraction", "Limit to Threshold" and "Display Label". Then press "m" (Analyse>Measure) and the 

area and percent area will be displayed in the "Results" window. Right click in the "Results" 

window and select "Save As" to save the results as a tab-delimited text file or select "Copy" to 

copy the results to the Clipboard. Once you set the measurement, check the global setting. When 

you open a new image, it will ask you to disable the global calibration, uncheck the box. In this 

way, all your image will be measured under same calibration and you don’t need to set the scale 

every time. 

 

Figure 5.4: Setting the option for uniform usage of color to quantify mucin 
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To quantify the acidic and neutral mucin, we need Color deconvolution plugin. Now this plugin 

has been replaced by Color convulation2 plugin. Download the jar/java file and extract it to the 

plugin folder of ImageJ. ImageJ>File>Open. Then once your image is opened in the ImageJ, go 

to color deconvulation2. 

 

Figure 5.5: Opening image for quantification 

In this case, this plugin is shown under plugin dropdown menu. 
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Figure 5.6: Opening color denconvulation option for mucin quantification 

Once you do this, it will ask you the type of staining.  
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Figure 5.7: Selecting appropriate stain for quantification of mucin 

In this case, its Alcian blue.  
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Figure 5.8: Selecting the appropriate staining 

You want to separate the blue from magenta/purple. Click OK and it will open 3 different windows 

with 3 different colors. Here the first one is purple color, second picture is our sample, third one is 

blue color and fourth one is white. We need to measure the ratio of purple and blue. 
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Figure 5.9: Pannel to select the image for quantifying mucin 

Select one picture, let’s say blue color, go to Image>Adjust>Threshold. Adjust the threshold 

according as per need. 
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Figure 5.10: Adjusting the threshold for quantification of mucin 

After adjusting, click Analyze>Analyze particles. Once you do that, this window will appear. 

Press OK. 
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Figure 5.11: Measuring red particles considered as acidic mucin 

Once you click OK, you will find this dialogue. Repeat the same for the purple slide.  
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Figure 5.12: Measuring window of mucin quantification (Acidic) 

Now its time to measure neutral mucin. Repeat the same but select PAS to identify the 

magenta/neutral mucin and select the Magenta picture (see below).  
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Figure 5.13: Measuring particles considered as neutral mucin 

Go to Image>Adjust>Threshold. Adjust the threshold according as per need. 
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Figure 5.14: Measuring red particles considered as neutral mucin 
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APPENDIX II 

 

DNA isolation  

Cecal genomic DNA was extracted using a FastDNA spin kit with a bead-beating step (MP 

Biomedicals, Lachine, QC, Canada). In a 2 mL Lysing Matrix E tube, 500 mg feces sample, 825 

μL Sodium Phosphate Buffer, and 275 μL of PLS solution were added and mixed with a shake. 

Then the solution was homogenized at 6.0m/s for 40 seconds. After homogenization, these were 

centrifuged at 14,000 x g for 5 minutes and supernatant was decanted. After decantation, 978 μL 

Sodium Phosphate Buffer and 122 μL MT Buffer were added to the tube and homogenized at 

6.0m/s for 40 seconds. This step is repeated after resting the samples on ice for 5 minutes. Then 

the samples were centrifuged at 14,000 x g for 15 minutes and supernatant was transferred to clean 

tube. Then to the tube, 250 μL of PPS solution were added, shaken vigorously to mix, incubated 

on a bucket of wet ice for 10 minutes and centrifuged it at 14,000 x g for 2 minutes. Then 

supernatant was transferred to the binding matrix solution in a new tube, shaken gently by hand to 

mix, then place on a shaker/rocker for 30 minutes. After this, centrifuged samples at 14,000 x g 

for 2 minutes and decanted the supernatant and washed the binding mixture pellet by gently 

resuspending with 1 mL Wash Buffer #1. Then transferred approximately 600 μL of the binding 

mixture to a SPIN Filter tube and centrifuge at 14,000 x g for 1 minute and emptied the catch tube. 

After that, added the remaining binding mixture to the SPIN Filter tube, centrifuged as before and 

emptied the catch tube again. After this, added 100mL of 100% ethanol to the wash buffer 2 and 

added 500 μL of prepared Wash Buffer #2 to the SPIN Filter tube and gently resuspend using the 

force of the liquid from the pipette tip to resuspend the pellet. Centrifuged the mixture at 14,000 x 

g for 2 minutes and discarded the flow-through. Then centrifuged the sample again for 2 minutes 

to extract residual ethanol from the binding matrix and dried the sample. After drying, transferred 
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the SPIN Filter bucket to a clean 1.9 mL Catch Tube and added 100 μL TES. At the last step, 

centrifuged samples at 14,000 x g for 2 minutes to elute purified DNA into the clean catch tube 

and discarded the SPIN filter. Stored at -80°C for extended periods. 

Quantification of DNA 

DNA quantification was performed on Thermo Nanodrop Spectrophotometer. For those samples, 

whose DNA content was low and salt content was higher, de-salting was performed. To perform 

de-salting, added 10 µl of NaCl (5M in water RNAs free water) to the DNA sample and inverted 

3-5 times to mix. Then added 250 µl of 100% cold EtOH to the DNA sample, inverted 3-5 times 

to mix and incubated the samples overnight at -20˚ C. Then centrifuged the samples at 10,000 g 

for 15 minutes at 4°C and decanted the liquid. After decantation, added 250 µl of 75% cold EtOH 

to DNA pellet, centrifuged at 10,000 g for 15 minutes at 4°C and dried the samples for 2-3 hours. 

Once its dried, dissolved DNA pellet in 50 µl TE Buffer and measured it with Thermo Nanodrop 

Spectrophotometer to ensure the DNA quantity. Then diluted the sample to get around 10 ng/uL of 

DNA and stored at -80˚ C before sending it to Integrated Microbiome Resource, Dalhousie 

University, NS. 

Bioinformatics  

All microbial analysis has been performed on R studio version 2023.06.1. After setting directory 

and importing file into R studio, data was prepared using command fnFs <- sort(list.files(path, 

pattern = "_R1_paired.fastq", full.names=TRUE)) for forward data and fnRs <-sort(list.files(path, 

pattern="_R2_paired.fastq", full.names=TRUE)) for reverse data. Then we extracted names using 

sample.names <- sapply(strsplit(basename(fnFs), "_"), '[',1) command.  

In  step 2, we inspected the forward and reverse sequence using plotQualityProfile(fnFs[1:52]) and 

plotQualityProfile(fnRs[1:52]) respectively. Then aggregated the data and generated quality plot 
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for forward and reverse data using plotQualityProfile(fnFs, aggregate = TRUE) and 

plotQualityProfile(fnRs, aggregate = TRUE) command, respectively.  

In step 3, we filtered and  trimmed the data using filtFs <-file.path(path, "filtered", 

paste0(sample.names, "_F_filt.fastq.gz")), filtRs <- file.path(path, "filtered", 

paste0(sample.names, "_R_filt.fastq.gz")) and out <- filterAndTrim(fnFs, filtFs, fnRs, 

filtRs,trimLeft = c(17,21), truncLen=c(260, 230), out <- filterAndTrim(fnFs, filtFs, fnRs, filtRs, 

truncLen=c(260, 230), maxN=0, maxEE=c(2,2), truncQ=2, rm.phix=TRUE,, compress=TRUE, 

multithread=FALSE) . After this step we saved the data to prevent the risk of losing data. To save 

the data, we have used saveRDS(out, file="out.vitamin"), out<-readRDS("out.vitamin") 

command. After this step, we checked the percent output using head(out), out.d <- data.frame(out), 

out.per<-out.d%>%, mutate(out.percent=(100*reads.out/reads.in)), head(out.per), View(out.d) 

commands.  

In step 4, we checked the error rate and plot error rate using errF <- learnErrors(filtFs, multithread 

= TRUE), errR <- learnErrors(filtRs, multithread = TRUE), saveRDS(errF, file="errF"), 

saveRDS(errR, file="errR") and plotErrors(errF, nominalQ=TRUE), plotErrors(errR, 

nominalQ=TRUE), dadaFs <-dada(filtFs, err=errF, multithread = TRUE), dadaRs <-dada(filtRs, 

err=errR, multithread = TRUE), saveRDS(dadaFs, file="dadaFs"), saveRDS(dadaRs, 

file="dadaRs"). 

In step 5, we merged the pairs using mergers <- mergePairs(dadaFs, filtFs, dadaRs, filtRs, 

verbose = TRUE), head(mergers[[1]]), saveRDS(mergers, file="mergers") and constructed 

sequence table seqtab <-makeSequenceTable (mergers), dim(seqtab), 

table(nchar(getSequences(seqtab))) commands. Then we removed sequence beyond 438:466 

using seqtab <- seqtab[, nchar(colnames(seqtab))%in% 438:466] command and removed 
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chimeras and saved the file using seqtab.nochim <-removeBimeraDenovo(seqtab, 

method="consensus", multithread=TRUE, verbose = TRUE), dim(seqtab.nochim), 

sum(seqtab.nochim)/sum(seqtab), saveRDS(seqtab.nochim, file = "seqtab.nochim"), 

write.csv(seqtab.nochim, file="seqtab.nochim"), read.csv2("seqtab.nochim"). 

In step 6, we summarized the ASV output using getN <- function(x) sum(getUniques(x)), track 

<- cbind(out, sapply(dadaFs, getN), sapply(dadaRs, getN), sapply(mergers, getN), 

rowSums(seqtab.nochim)), colnames(track) <- c("input", "filtered", "denoisedF", "denoisedR", 

"merged","nochim"), rownames(track)<-sample.names, head(track), track.d <- 

as.data.frame(track), merge.per <- track.d%>%, 

mutate(merge.percent=(100*merged/denoisedF)), nochim.per <- track.d%>%, 

mutate(nochimPer=(100*nochim/merged)), outputSum<-

cbind(track,out.per$out.percent,merge.per$merge.percent,nochim.per$nochimPer), 

colnames(outputSum) <-c("input", "filtered", "denoisedF", "denoisedR","Merged","Nochim", 

"out.Percent", "Merge.Percent","Nochim.Percent"), outputSum. 

Last step in this process is assigning taxonomy. We have used silva taxonomy in this study. To 

assign taxonomy, we have used SILVA <-

"C:/Users/kshru/Desktop/HossainTest/silva_nr_v138_train_set.fa.gz", SILVA.species <- 

"C:/Users/kshru/Desktop/HossainTest/Silva_species_assignment_v138.fa.gz", SILVA, 

SILVA.species, taxa.SILVA <- assignTaxonomy(seqtab.nochim, SILVA, multithread = T), 

head(taxa.SILVA), taxa.SILVA.species<- addSpecies(taxa.SILVA,SILVA.species), 

saveRDS(taxa.SILVA.species, file ="taxa.SILVA.species"), taxa.SILVA.print <-

taxa.SILVA.species, rownames(taxa.SILVA.print) <-NULL, dim(taxa.SILVA.print), 

head(taxa.SILVA.print), write.csv2(taxa.SILVA.print, file="SILVA.taxa"), 
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read.csv2("SILVA.taxa"), metadata<-

read.csv("C:/Users/kshru/Desktop/HossainTest/Hossain16SMetadataTest.csv", row.names = 1, 

header = TRUE), metadata, names <-rownames(seqtab.nochim), samdf <- data.frame(metadata), 

rownames(samdf), library(phyloseq), ps<- phyloseq(otu_table(seqtab.nochim, taxa_are_rows = 

FALSE), sample_data(samdf), tax_table(taxa.SILVA.species)), saveRDS(ps, file="ps.Hosaain"), 

ps. 
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APPENDIX III 

Metabolite analysis 

Dry, stool pellets were homogenized with a spatula and weighed out at 10-15 mg for all samples 

and a pooled quality control (QC) sample. Briefly, a pooled QC sample was prepared by taking 5 

mg of homogenized stool sample from all 47 samples within the study population.  A solution 

containing (70:30, MeOH:H2O) mix with 4 μM of recovery standards (trimethylamine-d9 N-oxide, 

creatinine-d3, 15N2-ornithine, 15N-histidine, choline-d9, carnitine-d3, 4-fluoro-L-phenylalanine, 

3-fluoro-L-tyrosine, gamma-aminobutyric acid-d6, methylhistidine-d3) was made and added to 

sample vials at 200 μL. Samples were then vortexed for 15 minutes at 2000 rpm and centrifuged 

for 10 minutes at 4000 rpm. 100 μL of supernatant was removed from vials and set aside prior to 

adding an additional 200 μL of the recovery standard mixture and repeating the vortexing and 

centrifugation process. 200 μL of supernatant was removed and combined with the first 100 μL of 

supernatant, yielding 300 μL of supernatant that was evaporated to dryness using nitrogen gas and 

subsequently reconstituted in 40 μLof a (70:30, MeOH:H2O) mix containing internal standards 

(IS) 40 μM of Cl-Tyr and NMS. All reconstituted samples were frozen at -80 °C and a 20 µL 

aliquot was transferred into a polypropylene vial for CE-MS analysis. An Agilent 6230B time-of-

flight (TOF) mass spectrometer with an electrospray ionization (ESI) source equipped to an 

Agilent G7100A capillary electrophoresis (CE) unit was used for all experiments (Agilent 

Technologies Inc., Mississauga, ON, Canada). An Agilent 1260 Infinity Isocratic pump and a 1260 

Infinity degasser were applied to deliver sheath liquid. A sheath liquid composition of 0.1% formic 

acid in (60:40 MeOH:H2O) and (70:30 MeOH:H2O) at a flow rate of 10 μL/min were used for 

positive and negative ion mode, respectively. For real-time mass correction, reference ions purine 

(20µL) and hexakis(2,2,3,3-tetrafluoropropoxy)phosphazine (HP-921, 20µL) were spiked into the 

sheath liquid (400 µL) at 0.02% v/v to provide constant mass signals. The nebulizer spray was set 



111 

 

off during the serial sample injection before being switched on at 4 psi (27.6 kPa) following voltage 

application. The source temperature was set to 300 °C and drying gas was delivered at 4 L/min. 

The instrument was operated under a 2 GHz extended dynamic range for positive and negative 

modes of detection. The Vcap, fragmentor, skimmer and octupole RF voltage were set to 3500 V, 

120 V, 65 V and 750 V, respectively. Separations were performed on bare fused-silica capillaries 

with a 50 μm internal diameter, a 360 μm outer diameter and a total length of 135 cm (Polymicro 

Technologies Inc.,AZ, USA). A capillary window maker (MicroSolv, Leland, NC, USA) was used 

to remove 7 mm of the polyimide coating on both ends of the capillary. All stool extract and QC 

samples were analyzed by MSI-CE-MS under two different configurations (positive and negative 

ionization modes). An acidic background electrolyte (BGE, 1 M formic acid with 15% vol 

acetonitrile, pH 1.8) was used for cationic metabolites under positive ion mode while an alkaline 

BGE (50 mM ammonium bicarbonate, pH 8.5 adjusted with ammonium hydroxide) was used for 

anionic metabolites under negative ion mode. Stool extracts were injected hydrodynamically at 

100 mbar (10 kPa) alternating between 5 s for each sample plug and 75 s for each BGE spacer 

plug which was electrokinetically injected at 30 kV. In total, thirteen discrete samples were 

analyzed within one run of 45 min. The applied voltage was set to 30 kV at 25 °C for CE 

separations together with a gradient pressure of 2 mbar/min. A list of metabolites was selected 

using in-house metabolite library and un-targeted list using MZmine software. This list of m/z 

(mass/charge) was extracted as extracted ion electropherograms (EIEs) from TIEs using Agilent 

MassHunter Workstation Qualitative 13 Analysis Software (version B.10.00, Agilent 

Technologies.) in profile mode with a 10 ppm masswindow and a smoothing function “Savitsky-

Golay quadratic/cubic function (7 pts)”. Corrective integration of EIE peaks yielded migration 

times (MT) and peak areas (PA) for each m/z that were transferred to Microsoft Excel (Microsoft 



112 

 

Office) and normalized to the MT and PA of internal standard to determine relative peak areas 

(RPAs) and relative migration times (RMTs), ultimately correcting for injection volume variability. 

Cl-Tyr and NMS were the primary internal standards used for normalization for positive and 

negative mode data, respectively. However, the metabolites with corresponding deuterated 

standards were normalized using their deuterated standards. Subsequently, all RPAs were 

normalized to their respective stool sample weight and duplicate RPAs from the same sample were 

averaged. The averaged, dry weight-normalized RPA data was used for all statistical analysis. 
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APPENDIX IV 

 

 

Figure 5.15: Duodeno-jejunum length of sprague-dawley rats after six weeks of exposure to 

vitamin-deficient diets before adjusting with body weights. Duodeno-jejunal lengths were 

significantly greater (p=0.03) in LB9 male rats (120.37±20.93 mm) compared to the control 

(95.92±4.42 mm) but no significant changes have been observed in males LB12 group. Similar 

findings were observed in both LB9 (100.43±6.90 mm), and LB12 (97.37±5.08 mm) females 

compared to the control (88.43±7.19 mm) (p=0.004). ab Groups with different letters are 

significantly different by one way ANOVA-test. Values are expressed as mean ± SD, n=8 in LB9 

and LB12 and n=7 in Control in males and n= 8 / group in females. 
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Table 5.1: Body weights, organ weights* after six weeks of treatment with vitamin B9 and B12 deficient diet  

Treatment Body weight* 

Organ weights (%) 

Male Female 

Heart  Brain Liver  Kidney Heart Brain  Liver  Kidney 

Control 359.67±117.69 0.31±0.03 0.49±0.17 3.04±0.35 0.64±0.02 0.29±0.13 0.75±0.29 3.05±0.4 0.65±0.1 

LB9 347.83±111.42 0.29±0.03 0.4±0.04 3.3±0.51 0.68±0.13 0.29±0.11 0.64±0.07 2.87±0.53 0.61±0.05 

LB12 362.5±103.23 0.26±0.1 0.34±0.14 3.36±0.57 0.7±0.15 0.41±0.37 0.77±0.19 2.91±0.24 0.73±0.24 

p-value 0.7 0.39 0.1 0.41 0.61 0.5 0.4 0.34 0.345 

Values are expressed as mean ± SD, n=8 in LB9 and LB12 and n=7 in Control in males and n= 8 / group in females. # Based on 

treatment. * Adjusted weight and length with body weight using the formula below: 

% 𝑤𝑒𝑖𝑔ℎ𝑡 =
𝑂𝑟𝑔𝑎𝑛 𝑤𝑒𝑖𝑔ℎ𝑡

𝐵𝑜𝑑𝑦 𝑤𝑒𝑖𝑔ℎ𝑡
× 100 
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Table 5.2: Intestinal length * after six weeks of treatment with vitamin B9 and B12 deficient diet  

  

Treatment 

Organ length (%) 

Duodeno-jejunal length     

Male Female Ileum Colon 

Control 20.52±1.63 34.07±4.35 0.62±0.34 3.32±0.52 

LB9 24.65±4.4 36.99±5.21 0.64±0.33 3.46±0.98 

LB12 24.32±5.17 36.87±4.22 0.49±0.19 3.5±1.15 

p-value 0.15 0.375 0.67 0.96 

Values are expressed as mean ± SD, n=8 in LB9 and LB12 and n=7 in Control in males and n= 8 

/ group in females. * Adjusted length with body weight using the formula below: 

% 𝑤𝑒𝑖𝑔ℎ𝑡 =
𝑂𝑟𝑔𝑎𝑛 𝑙𝑒𝑛𝑔𝑡ℎ

𝐵𝑜𝑑𝑦 𝑤𝑒𝑖𝑔ℎ𝑡
× 100 

 


